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You can share this PDF with anyone you feel could benefit from it, downloaded the latest version 
from: kotlin

It is an unofficial and free Kotlin ebook created for educational purposes. All the content is 
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1: Kotlinをいめる
Kotlinは、にJVMをとするJetBrainsによってされたオブジェクトプログラミングです。 Kotlinは、
コンパイル、、に、100Javaとのというをってされています。 Kotlinはまた、Javaがむくのをす
ることをにされています。 Kotlinのコンパイラでは、JVMのJavaバイトコードとJavaScriptのにコ
ンパイルできます。

Kotlinをコンパイルする

Kotlinには、EclipseとIntelliJのIDEプラグインがあります。 KotlinはMavenをって、Antをって、
Gradleをって 、またはコマンドラインからコンパイルすることもできます。

$ kotlinc Main.ktはjavaクラスファイルをします。この、 MainKt.class クラスにKtがされているこ
とにしてください。しかし、 $ java MainKt javaをしてクラスファイルをすると、のがスローされ
ます。

Exception in thread "main" java.lang.NoClassDefFoundError: kotlin/jvm/internal/Intrinsics 
    at MainKt.main(Main.kt) 
Caused by: java.lang.ClassNotFoundException: kotlin.jvm.internal.Intrinsics 
    at java.net.URLClassLoader.findClass(URLClassLoader.java:381) 
    at java.lang.ClassLoader.loadClass(ClassLoader.java:424) 
    at sun.misc.Launcher$AppClassLoader.loadClass(Launcher.java:335) 
    at java.lang.ClassLoader.loadClass(ClassLoader.java:357) 
    ... 1 more 
 

Javaをしてのクラスファイルをするには、のクラスパスにKotlinランタイムJarファイルをめるが
あります。

java -cp .:/path/to/kotlin/runtime/jar/kotlin-runtime.jar MainKt

バージョン

バージョン

1.0.0 2016-02-15

1.0.1 2016-03-16

1.0.2 2016513

1.0.3 2016630

1.0.4 2016-09-22

1.0.5 2016-11-08
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バージョン

1.0.6 2016-12-27

1.1.0 2017-03-01

1.1.1 2017-03-14

1.1.2 2017-04-25

1.1.3 2017-06-23

Examples

こんにちは

てのKotlinプログラムはmainからまります。なKotlinの "Hello World"プログラムのをにします。

package my.program 
 
fun main(args: Array<String>) { 
    println("Hello, world!") 
}

のコードをMain.ktというのファイルにMain.ktますこのファイルはにです

JVMをとする、ファンクションはファイルからしたをつクラスのメソッドとしてコンパイルされ
ます。のでは、するメインクラスはmy.program.MainKtです。

のファイルのトップレベルをむクラスのをするには、ファイルのにpackageステートメントのに
のアノテーションをします。

@file:JvmName("MyApp")

このでは、するメインクラスはmy.program.MyAppなりmy.program.MyApp 。

@JvmNameアノテーションをむパッケージレベルの 。•
アノテーションサイトのターゲット•

オブジェクトをしたHello World

わりに、KotlinプログラムのmainをむObject Declarationをすることもできます。

package my.program 
 
object App { 
    @JvmStatic fun main(args: Array<String>) { 
        println("Hello World") 
    } 
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}

するクラスはオブジェクトので、このはmy.program.Appです。

このメソッドのトップレベルのは、するクラスがであり、するのがクラスAppスコープされている
ことです。また、ステートをしてのをうためのSingletonのAppインスタンスもあります。

@JvmStaticアノテーションをむメソッド•

コンパニオンオブジェクトをしたHello World

オブジェクトとに、クラスのコンパニオンオブジェクトをしてKotlinプログラムのmainをすること
ができます。

package my.program 
 
class App { 
    companion object { 
        @JvmStatic fun main(args: Array<String>) { 
            println("Hello World") 
        } 
    } 
}

するクラスはクラスので、このはmy.program.Appです。

このメソッドのトップレベルのは、するクラスがであり、するのがクラスAppスコープされている
ことです。これは、 Object Declarationとていますが、それのをうためにクラスをインスタンスす
ることをしていることはじです。

の "hello"をうためにクラスをインスタンスするわずかなバリエーション

class App { 
    companion object { 
        @JvmStatic fun main(args: Array<String>) { 
            App().run() 
        } 
    } 
 
    fun run() { 
        println("Hello World") 
    } 
}

@JvmStaticアノテーションをむメソッド•

varargsをするなメソッド

これらのなメソッドスタイルは、すべてvarargsですることもできます 
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package my.program 
 
fun main(vararg args: String) { 
    println("Hello, world!") 
}

コマンドラインでKotlinコードをコンパイルしてする

javaはJavaコードをコンパイルしするための2つのなるコマンドをしています。 Kotlinとじことは
あなたに々のコマンドをします。

javaファイルをコンパイルするjavac 。 javaはjavaファイルをします。

じkotlinc kotlinファイルをコンパイルするには、 kotlinファイルをkotlinします。

コマンドラインからののみり

コンソールからされたは、Kotlinプログラムでけることができ、としてできます。コマンドプロン
プトからN1 2 3などのをすことができます。

Kotlinのコマンドラインのな。

fun main(args: Array<String>) { 
 
    println("Enter Two number") 
    var (a, b) = readLine()!!.split(' ') // !! this operator use for 
NPE(NullPointerException). 
 
    println("Max number is : ${maxNum(a.toInt(), b.toInt())}") 
} 
 
 
 
fun maxNum(a: Int, b: Int): Int { 
 
    var max = if (a > b) { 
        println("The value of a is $a"); 
        a 
    } else { 
        println("The value of b is $b") 
        b 
    } 
 
    return max; 
 
}

ここでは、をつけるためにコマンドラインから2つのをします。

Enter Two number 
71 89 // Enter two number from command line 
 
The value of b is 89 
Max number is: 89
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にとって オペレータNull Safetyをチェックしてください。

のはIntellijでコンパイルしてします。

オンラインでKotlinをいめるをむ https://riptutorial.com/ja/kotlin/topic/490/kotlinをいめる
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2: DSLビルディング

き

KotlinのDSLをするためののにしてください。

Examples

DSLをするためのインフィクスアプローチ

あなたがっている

infix fun <T> T?.shouldBe(expected: T?) = assertEquals(expected, this)

あなたのテストでは、のようなDSLのようなコードをくことができます

@Test 
fun test() { 
  100.plusOne() shouldBe 101 
}

DSLをするためのinvokeメソッドのオーバーライド

あなたがっている

class MyExample(val i: Int) { 
  operator fun <R> invoke(block: MyExample.() -> R) = block() 
  fun Int.bigger() = this > i 
}

プロダクションコードにのDSLのようなコードをくことができます

fun main2(args: Array<String>) { 
    val ex = MyExample(233) 
    ex { 
        // bigger is defined in the context of `ex` 
        // you can only call this method inside this context 
        if (777.bigger()) kotlin.io.println("why") 
    } 
}

ラムダでのの

あなたがっている

val r = Random(233) 
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infix inline operator fun Int.rem(block: () -> Unit) { 
  if (r.nextInt(100) < this) block() 
}

のDSLのようなコードをくことができます

20 % { println("The possibility you see this message is 20%") }

ラムダでのの

あなたがっている

operator fun <R> String.invoke(block: () -> R) = { 
  try { block.invoke() } 
  catch (e: AssertException) { System.err.println("$this\n${e.message}") } 
}

のDSLのようなコードをくことができます

"it should return 2" { 
   parse("1 + 1").buildAST().evaluate() shouldBe 2 
}

あなたがのshouldBeとしているとじたら、 Infix approach to build DSL shouldBe Infix approach to 
build DSLのをしてください。

オンラインでDSLビルディングをむ https://riptutorial.com/ja/kotlin/topic/10042/dslビルディング
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3: Java 8ストリームにするもの

き

Kotlinは、をするためのコレクションおよびiterableにするくのメソッドをしています。のSequence

では、このようなのいくつかをけにすることができます。

について

チェーンをしたいは、チェーンのにasSequence()をしてSequenceできます。ののわりには、、 
Sequenceもします。に、 toList() 、 toSet() 、 toMap()またはのをして、にSequenceをすることがで
きます。

// switch to and from lazy 
val someList = items.asSequence().filter { ... }.take(10).map { ... }.toList() 
 
// switch to lazy, but sorted() brings us out again at the end 
val someList = items.asSequence().filter { ... }.take(10).map { ... }.sorted()

なぜがないのですか

Kotlinのではがされていないことにづくでしょう。これは、Kotlinがなをち、コンパイルになので
あるためです。 Javaにはヌルながあり、ろしいNPEをぐのにつので、Javaほどです。それで
Kotlinでこれは

val someList = people.filter { it.age <= 30 }.map { it.name }

のものとじです

val someList: List<String> = people.filter { it.age <= 30 }.map { it.name }

Kotlinはをっているのでpeopleあり、そのpeople.ageあるIntしたがって、フィルタはのみとのがで
きInt 、そのpeople.nameあるStringため、 mapステップがするList<String> みりListのString 。

、 List<People>?ようにpeopleがおそらくnullはList<People>?に

val someList = people?.filter { it.age <= 30 }?.map { it.name }

List<String>?しますList<String>?  nullをうためにこのKotlinのなをしてください。また、 Kotlinで 

nullableまたはのリストを するなもしてください 

ストリームの
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コトリンでは、それが1されるかどうかは、のタイプにする。 Sequenceはしいイテレータをし、「
1のみ」をアサートしないり、するたびににリセットすることができます。したがって、Java 8ス
トリームではのようにしますが、Kotlinではします。

// Java: 
Stream<String> stream = 
Stream.of("d2", "a2", "b1", "b3", "c").filter(s -> s.startsWith("b")); 
 
stream.anyMatch(s -> true);    // ok 
stream.noneMatch(s -> true);   // exception

// Kotlin: 
val stream = listOf("d2", "a2", "b1", "b3", "c").asSequence().filter { it.startsWith('b' ) } 
 
stream.forEach(::println) // b1, b2 
 
println("Any B ${stream.any { it.startsWith('b') }}") // Any B true 
println("Any C ${stream.any { it.startsWith('c') }}") // Any C false 
 
stream.forEach(::println) // b1, b2

そして、Javaではじをる

// Java: 
Supplier<Stream<String>> streamSupplier = 
    () -> Stream.of("d2", "a2", "b1", "b3", "c") 
          .filter(s -> s.startsWith("a")); 
 
streamSupplier.get().anyMatch(s -> true);   // ok 
streamSupplier.get().noneMatch(s -> true);  // ok

したがって、Kotlinでは、データのプロバイダがリセットしてしいイテレータをするかどうかをし
ます。しかし、にSequenceを1のにしたいは、のようにSequence constrainOnce()をできます。

val stream = listOf("d2", "a2", "b1", "b3", "c").asSequence().filter { it.startsWith('b' ) } 
        .constrainOnce() 
 
stream.forEach(::println) // b1, b2 
stream.forEach(::println) // Error:java.lang.IllegalStateException: This sequence can be 
consumed only once. 

Iterableのの APIリファレンス•

のの APIリファレンス•

Listのの APIリファレンス•

Mapへのの APIリファレンス•

Examples

リストのをする
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// Java: 
List<String> list = people.stream().map(Person::getName).collect(Collectors.toList());

// Kotlin: 
val list = people.map { it.name }  // toList() not needed

をにし、コンマでってする

// Java: 
String joined = things.stream() 
                       .map(Object::toString) 
                       .collect(Collectors.joining(", "));

// Kotlin: 
val joined = things.joinToString() // ", " is used as separator, by default

の

// Java: 
int total = employees.stream() 
                      .collect(Collectors.summingInt(Employee::getSalary)));

// Kotlin: 
val total = employees.sumBy { it.salary }

// Java: 
Map<Department, List<Employee>> byDept 
     = employees.stream() 
                .collect(Collectors.groupingBy(Employee::getDepartment));

// Kotlin: 
val byDept = employees.groupBy { it.department }

の

// Java: 
Map<Department, Integer> totalByDept 
     = employees.stream() 
                .collect(Collectors.groupingBy(Employee::getDepartment, 
                     Collectors.summingInt(Employee::getSalary)));

// Kotlin: 
val totalByDept = employees.groupBy { it.dept }.mapValues { it.value.sumBy { it.salary }}

をとにする

// Java: 
Map<Boolean, List<Student>> passingFailing = 
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     students.stream() 
             .collect(Collectors.partitioningBy(s -> s.getGrade() >= PASS_THRESHOLD));

// Kotlin: 
val passingFailing = students.partition { it.grade >= PASS_THRESHOLD }

メンバーの

// Java: 
List<String> namesOfMaleMembersCollect = roster 
    .stream() 
    .filter(p -> p.getGender() == Person.Sex.MALE) 
    .map(p -> p.getName()) 
    .collect(Collectors.toList());

// Kotlin: 
val namesOfMaleMembers = roster.filter { it.gender == Person.Sex.MALE }.map { it.name }

のメンバーのによるグループ

// Java: 
Map<Person.Sex, List<String>> namesByGender = 
      roster.stream().collect( 
        Collectors.groupingBy( 
            Person::getGender, 
            Collectors.mapping( 
                Person::getName, 
                Collectors.toList())));

// Kotlin: 
val namesByGender = roster.groupBy { it.gender }.mapValues { it.value.map { it.name } } 

リストをのリストにフィルターする

// Java: 
List<String> filtered = items.stream() 
    .filter( item -> item.startsWith("o") ) 
    .collect(Collectors.toList());

// Kotlin: 
val filtered = items.filter { item.startsWith('o') } 

のをする

// Java: 
String shortest = items.stream() 
    .min(Comparator.comparing(item -> item.length())) 
    .get();
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// Kotlin: 
val shortest = items.minBy { it.length }

なるのストリーム2 - のアイテムがけているはする

// Java: 
Stream.of("a1", "a2", "a3") 
    .findFirst() 
    .ifPresent(System.out::println); 

// Kotlin: 
sequenceOf("a1", "a2", "a3").firstOrNull()?.apply(::println)

なるのストリーム3 - のをする

// Java: 
IntStream.range(1, 4).forEach(System.out::println);

// Kotlin:  (inclusive range) 
(1..3).forEach(::println)

なるのストリーム4 - をし、をマップし、をする

// Java: 
Arrays.stream(new int[] {1, 2, 3}) 
    .map(n -> 2 * n + 1) 
    .average() 
    .ifPresent(System.out::println); // 5.0 

// Kotlin: 
arrayOf(1,2,3).map { 2 * it + 1}.average().apply(::println)

ストリームの5 - のリストをにし、をマップし、Intにし、をつける

// Java: 
Stream.of("a1", "a2", "a3") 
    .map(s -> s.substring(1)) 
    .mapToInt(Integer::parseInt) 
    .max() 
    .ifPresent(System.out::println);  // 3

// Kotlin: 
sequenceOf("a1", "a2", "a3") 
    .map { it.substring(1) } 
    .map(String::toInt) 
    .max().apply(::println)

ストリームののい6 - Intsのストリームをさせ、をマップし、をする
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// Java: 
IntStream.range(1, 4) 
    .mapToObj(i -> "a" + i) 
    .forEach(System.out::println); 
 
// a1 
// a2 
// a3 

// Kotlin:  (inclusive range) 
(1..3).map { "a$it" }.forEach(::println)

なるのストリーム7 - をにりす、Intにマップする、Stringにマップする、それぞれを
する

// Java: 
Stream.of(1.0, 2.0, 3.0) 
    .mapToInt(Double::intValue) 
    .mapToObj(i -> "a" + i) 
    .forEach(System.out::println); 
 
// a1 
// a2 
// a3

// Kotlin: 
sequenceOf(1.0, 2.0, 3.0).map(Double::toInt).map { "a$it" }.forEach(::println)

フィルタがされたにリストのアイテムをえる

// Java: 
long count = items.stream().filter( item -> item.startsWith("t")).count();

// Kotlin: 
val count = items.filter { it.startsWith('t') }.size 
// but better to not filter, but count with a predicate 
val count = items.count { it.startsWith('t') }

ストリームのみ - フィルタリング、、リストのべえ

// Java: 
List<String> myList = Arrays.asList("a1", "a2", "b1", "c2", "c1"); 
 
myList.stream() 
      .filter(s -> s.startsWith("c")) 
      .map(String::toUpperCase) 
     .sorted() 
     .forEach(System.out::println); 
 
// C1 
// C2
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// Kotlin: 
val list = listOf("a1", "a2", "b1", "c2", "c1") 
list.filter { it.startsWith('c') }.map (String::toUpperCase).sorted() 
        .forEach (::println)

なるのストリーム1 - のアイテムがあればそれをう

// Java: 
Arrays.asList("a1", "a2", "a3") 
    .stream() 
    .findFirst() 
    .ifPresent(System.out::println); 

// Kotlin: 
listOf("a1", "a2", "a3").firstOrNull()?.apply(::println)

または、ifPresentとばれるStringのをします。

// Kotlin: 
inline fun String?.ifPresent(thenDo: (String)->Unit) = this?.apply { thenDo(this) } 
 
// now use the new extension function: 
listOf("a1", "a2", "a3").firstOrNull().ifPresent(::println)

apply()

?.セーフコールオペレータであり、にnull http : //stackoverflow.com/questions/34498562/in-kotlin-
what-is-the-idiomatic-way-to-deal-with-nullable-values-referencing-o/34498563 34498563

コレクション5 - のをしし、フォーマットされたをする

// Java: 
String phrase = persons 
        .stream() 
        .filter(p -> p.age >= 18) 
        .map(p -> p.name) 
        .collect(Collectors.joining(" and ", "In Germany ", " are of legal age.")); 
 
System.out.println(phrase); 
// In Germany Max and Peter and Pamela are of legal age. 

// Kotlin: 
val phrase = persons 
        .filter { it.age >= 18 } 
        .map { it.name } 
        .joinToString(" and ", "In Germany ", " are of legal age.") 
 
println(phrase) 
// In Germany Max and Peter and Pamela are of legal age.

さらに、Kotlinでは、なデータクラスをし、のようにテストデータをインスタンスできます。
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// Kotlin: 
// data class has equals, hashcode, toString, and copy methods automagically 
data class Person(val name: String, val age: Int) 
 
val persons = listOf(Person("Tod", 5), Person("Max", 33), 
                     Person("Frank", 13), Person("Peter", 80), 
                     Person("Pamela", 18))

コレクションの6をする - 、、をにグループする

// Java: 
Map<Integer, String> map = persons 
        .stream() 
        .collect(Collectors.toMap( 
                p -> p.age, 
                p -> p.name, 
                (name1, name2) -> name1 + ";" + name2)); 
 
System.out.println(map); 
// {18=Max, 23=Peter;Pamela, 12=David} 

それでは、Kotlinにとってもっといケースです。まず、コレクション/シーケンスからMapをするの
いをべるったえ

// Kotlin: 
val map1 = persons.map { it.age to it.name }.toMap() 
println(map1) 
// output: {18=Max, 23=Pamela, 12=David} 
// Result: duplicates overridden, no exception similar to Java 8 
 
val map2 = persons.toMap({ it.age }, { it.name }) 
println(map2) 
// output: {18=Max, 23=Pamela, 12=David} 
// Result: same as above, more verbose, duplicates overridden 
 
val map3 = persons.toMapBy { it.age } 
println(map3) 
// output: {18=Person(name=Max, age=18), 23=Person(name=Pamela, age=23), 12=Person(name=David, 
age=12)} 
// Result: duplicates overridden again 
 
val map4 = persons.groupBy { it.age } 
println(map4) 
// output: {18=[Person(name=Max, age=18)], 23=[Person(name=Peter, age=23), Person(name=Pamela, 
age=23)], 12=[Person(name=David, age=12)]} 
// Result: closer, but now have a Map<Int, List<Person>> instead of Map<Int, String> 
 
val map5 = persons.groupBy { it.age }.mapValues { it.value.map { it.name } } 
println(map5) 
// output: {18=[Max], 23=[Peter, Pamela], 12=[David]} 
// Result: closer, but now have a Map<Int, List<String>> instead of Map<Int, String>

それではのために

// Kotlin: 
val map6 = persons.groupBy { it.age }.mapValues { it.value.joinToString(";") { it.name } } 
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println(map6) 
// output: {18=Max, 23=Peter;Pamela, 12=David} 
// Result: YAY!!

はちょうどリストをりたたむとするをするために、するをするためになjoinToStringからする
PersonにインスタンスPerson.name 。

サンプルの7a - マップ、デリミタとの

// Java (verbose): 
Collector<Person, StringJoiner, String> personNameCollector = 
Collector.of( 
        () -> new StringJoiner(" | "),          // supplier 
        (j, p) -> j.add(p.name.toUpperCase()),  // accumulator 
        (j1, j2) -> j1.merge(j2),               // combiner 
        StringJoiner::toString);                // finisher 
 
String names = persons 
        .stream() 
        .collect(personNameCollector); 
 
System.out.println(names);  // MAX | PETER | PAMELA | DAVID 
 
// Java (concise) 
String names = persons.stream().map(p -> p.name.toUpperCase()).collect(Collectors.joining(" | 
"));

// Kotlin: 
val names = persons.map { it.name.toUpperCase() }.joinToString(" | ")

サンプル7bをめる - SummarizingIntでする

// Java: 
IntSummaryStatistics ageSummary = 
    persons.stream() 
           .collect(Collectors.summarizingInt(p -> p.age)); 
 
System.out.println(ageSummary); 
// IntSummaryStatistics{count=4, sum=76, min=12, average=19.000000, max=23} 

// Kotlin: 
 
// something to hold the stats... 
data class SummaryStatisticsInt(var count: Int = 0, 
                                var sum: Int = 0, 
                                var min: Int = Int.MAX_VALUE, 
                                var max: Int = Int.MIN_VALUE, 
                                var avg: Double = 0.0) { 
    fun accumulate(newInt: Int): SummaryStatisticsInt { 
        count++ 
        sum += newInt 
        min = min.coerceAtMost(newInt) 
        max = max.coerceAtLeast(newInt) 
        avg = sum.toDouble() / count 
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        return this 
    } 
} 
 
// Now manually doing a fold, since Stream.collect is really just a fold 
val stats = persons.fold(SummaryStatisticsInt()) { stats, person -> 
stats.accumulate(person.age) } 
 
println(stats) 
// output: SummaryStatisticsInt(count=4, sum=76, min=12, max=23, avg=19.0)

しかし、にはKotlin stdlibのスタイルにマッチする2つのをするがいです

// Kotlin: 
inline fun Collection<Int>.summarizingInt(): SummaryStatisticsInt 
        = this.fold(SummaryStatisticsInt()) { stats, num -> stats.accumulate(num) } 
 
inline fun <T: Any> Collection<T>.summarizingInt(transform: (T)->Int): SummaryStatisticsInt = 
        this.fold(SummaryStatisticsInt()) { stats, item -> stats.accumulate(transform(item)) }

しいsummarizingIntをするには、の2つのがあります。

val stats2 = persons.map { it.age }.summarizingInt() 
 
// or 
 
val stats3 = persons.summarizingInt { it.age }

これらのすべてがじをみします。また、このをしてSequenceとなプリミティブにしてすることも
できます。

オンラインでJava 8ストリームにするものをむ https://riptutorial.com/ja/kotlin/topic/707/java-8スト
リームにするもの
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4: JavaのためのKotlin

き

Kotlinにるほとんどのは、Javaでプログラミングのをっています。

このトピックでは、JavaとKotlinをして、もなとKotlinがJavaでするをするをします。

Examples

の

Kotlinでは、のはJavaのものとしってえます

val i : Int = 42

らはどちらかでまるvalやvarり、 final 「 ヴァル UE」またはVARの iableを。•

タイプはのにされ、 :にられます:•

Kotlinののおかげで、なは、コンパイラがにできるをつ•

Java コトリン

int i = 42; var i = 42  または var i : Int = 42 

final int i = 42; val i = 42

コトリンはありません;ステートメントをする•
Kotlinはnullセーフです•

Kotlinは100Javaのがあります•

Kotlinにはプリミティブはありませんが であれば、JVMのオブジェクトをします•

Kotlinクラスにはプロパティがあり、フィールドはありません•

Kotlinは、されたequals / hashCodeメソッドとフィールドアクセサーをつデータクラスをして
います

•

Kotlinにはランタイムのみがあり、 チェックはありません•

Kotlinにはnewキーワードはありません 。オブジェクトをするには、のメソッドとじように
コンストラクタをびすだけです。

•

Kotlinはられた のオーバーロードをサポートしています。たとえば、マップのにアクセスす
るには、 val a = someMap["key"]

•

Kotlinは、JVMのバイトコードだけでなく、 Java Scriptにもコンパイルできるだけでなく
、Kotlinにバックエンドコードとフロントエンドコードのをくことができます

•

Kotlinは、Java 6とにがあります 。これは、それほどいAndroidデバイスのサポートにして•
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にいものです
KotlinはAndroidに にサポートされているです•

Kotlinのコレクションには、 なコレクションとなコレクションのにみみのがあります 。•

コトリンはコルーチンをサポートしています•

とアイデンティティ

Kotlinはしています==のためにつまり、びしますequalsとを===アイデンティティのために。

Java コトリン

a.equals(b); a == b

a == b; a === b

a != b; a !== b

https : //kotlinlang.org/docs/reference/equality.html

IF、TRYなどはであり、ではありません。

Kotlinでは、 if 、 try 、およびothersはではなくをすため、voidステートメントではありません。

たとえば、KotlinにはJavaのElvisはありませんが、のようにくことができます

val i = if (someBoolean) 33 else 42

さらによくられていないが、にかなのは、 try です。

val i = try { 
    Integer.parseInt(someString) 
} 
catch (ex : Exception) 
{ 
    42 
}

オンラインでJavaのためのKotlinをむ https://riptutorial.com/ja/kotlin/topic/10099/javaのための
kotlin
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5: JUnit

Examples

ルール

JUnit ルールをテストフィクスチャにするには

@Rule @JvmField val myRule = TemporaryFolder()

@JvmFieldアノテーションは、 myRuleプロパティとじpublicをつバッキングフィールドをするため
にです 。 JUnitルールでは、きルールフィールドをするがあります。

オンラインでJUnitをむ https://riptutorial.com/ja/kotlin/topic/6973/junit
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6: Kotlin Android

き

Kotlinには、バインディングやButterKnifeなどのフレームワークのをスキップできるように、
Androidのビューインジェクションがみまれています。いくつかのは、よりい、よりいなけ、した
がってエラーがこりにくいことです。

Examples

にされたgradleプロジェクトからめます 。

プロジェクトのローカル トップレベルではない build.gradle 、Kotlinプラグインのにトップレベ
ルのインデントレベルでエクステンションプラグインをします。

buildscript { 
    ... 
} 
 
apply plugin: "com.android.application" 
... 
apply plugin: "kotlin-android" 
apply plugin: "kotlin-android-extensions" 
...

ビューの

々はとばれるレイアウトでしているとすると、 activity_main.xml 

<?xml version="1.0" encoding="utf-8"?> 
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android" 
    android:layout_width="match_parent" 
    android:layout_height="match_parent"> 
 
    <Button 
        android:id="@+id/my_button" 
        android:layout_width="wrap_content" 
        android:layout_height="wrap_content" 
        android:text="My button"/> 
</LinearLayout>

Kotlinのをして、のようなバインディングなしでボタンをびすことができます

import kotlinx.android.synthetic.main.activity_main.my_button 
 
class MainActivity: Activity() { 
    override fun onCreate(savedInstanceBundle: Bundle?) { 
        super.onCreate(savedInstanceBundle) 
        setContentView(R.layout.activity_main) 
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        // my_button is already casted to a proper type of "Button" 
        // instead of being a "View" 
        my_button.setText("Kotlin rocks!") 
    } 
}

レイアウトにされるすべてのIDを*でインポートすることもできます

// my_button can be used the same way as before 
import kotlinx.android.synthetic.main.activity_main.*

ビューは、そのレイアウトのアクティビティ/フラグメント/ビューのではできません。

import kotlinx.android.synthetic.main.activity_main.my_button 
 
class NotAView { 
    init { 
        // This sample won't compile! 
        my_button.setText("Kotlin rocks!") 
    } 
}

の

AndroidのはのAndroid Product Flavorsでもします。たとえば、 build.gradleようながあるとしま
す。

android { 
    productFlavors { 
        paid { 
            ... 
        } 
        free { 
            ... 
        } 
    } 
}

そして、えば、フリーフレーバーだけがボタンをっています

<?xml version="1.0" encoding="utf-8"?> 
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android" 
    android:layout_width="match_parent" 
    android:layout_height="match_parent"> 
 
    <Button 
        android:id="@+id/buy_button" 
        android:layout_width="wrap_content" 
        android:layout_height="wrap_content" 
        android:text="Buy full version"/> 
</LinearLayout>

たちはにフレーバーにバインドすることができます
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import kotlinx.android.synthetic.free.main_activity.buy_button

ビューがにされたときにをけるためのをじるリスナーは、Kotlinのでとてもシンプ
ルでらしい

mView.afterMeasured { 
  // inside this block the view is completely drawn 
  // you can get view's height/width, it.height / it.width 
}

フードの

inline fun View.afterMeasured(crossinline f: View.() -> Unit) { 
viewTreeObserver.addOnGlobalLayoutListener(object : ViewTreeObserver.OnGlobalLayoutListener { 
    override fun onGlobalLayout() { 
        if (measuredHeight > 0 && measuredWidth > 0) { 
            viewTreeObserver.removeOnGlobalLayoutListener(this) 
            f() 
        } 
    } 
}) 
}

オンラインでKotlin Androidをむ https://riptutorial.com/ja/kotlin/topic/9474/kotlin-android
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7: KotlinのRecyclerView

き

はちょうどKotlinをしてのしのとRecyclerViewのコードをしたいといます。

Examples

メインクラスとアダプター

はあなたがKotlinのとをっているとしています。にactivity_main.xmlファイルにRecyclerView
をし、アダプタクラスをしてください。

class MainActivity : AppCompatActivity(){ 
 
        lateinit var mRecyclerView : RecyclerView 
        val mAdapter : RecyclerAdapter = RecyclerAdapter() 
 
        override fun onCreate(savedInstanceState: Bundle?) { 
            super.onCreate(savedInstanceState) 
            setContentView(R.layout.activity_main) 
            val toolbar = findViewById(R.id.toolbar) as Toolbar 
            setSupportActionBar(toolbar) 
 
            mRecyclerView = findViewById(R.id.recycler_view) as RecyclerView 
 
            mRecyclerView.setHasFixedSize(true) 
            mRecyclerView.layoutManager = LinearLayoutManager(this) 
            mAdapter.RecyclerAdapter(getList(), this) 
            mRecyclerView.adapter = mAdapter 
        } 
 
        private fun getList(): ArrayList<String> { 
            var list : ArrayList<String> = ArrayList() 
            for  (i in 1..10) { // equivalent of 1 <= i && i <= 10 
                println(i) 
                list.add("$i") 
            } 
            return list 
        } 
    }

これはあなたのリサイクラ・ビュー・アダプタ・クラスであり、 main_item.xmlファイルをします。

class RecyclerAdapter : RecyclerView.Adapter<RecyclerAdapter.ViewHolder>() { 
 
    var mItems: ArrayList<String>  = ArrayList() 
    lateinit var mClick : OnClick 
 
    fun RecyclerAdapter(item : ArrayList<String>, mClick : OnClick){ 
        this.mItems = item 
        this.mClick = mClick; 
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    } 
 
    override fun onBindViewHolder(holder: ViewHolder, position: Int) { 
        val item = mItems[position] 
        holder.bind(item, mClick, position) 
    } 
 
    override fun onCreateViewHolder(parent: ViewGroup, viewType: Int): ViewHolder { 
        val layoutInflater = LayoutInflater.from(parent.context) 
        return ViewHolder(layoutInflater.inflate(R.layout.main_item, parent, false)) 
    } 
 
    override fun getItemCount(): Int { 
        return mItems.size 
    } 
 
    class ViewHolder(view: View) : RecyclerView.ViewHolder(view) { 
        val card = view.findViewById(R.id.card) as TextView 
        fun bind(str: String, mClick: OnClick, position: Int){ 
            card.text = str 
            card.setOnClickListener { view -> 
                mClick.onClickListner(position) 
            } 
        } 
    } 
}

オンラインでKotlinのRecyclerViewをむ https://riptutorial.com/ja/kotlin/topic/10143/kotlinの
recyclerview
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8: Kotlinのループ
Kotlinでは、ループはなりされたループにコンパイルされます。たとえば、をする、オブジェクト
のオーバーヘッドをけるために、バイトコードはなintにづいてするループにコンパイルされます
。

Examples

アクションをxりします。

repeat(10) { i -> 
    println("This line will be printed 10 times") 
    println("We are on the ${i + 1}. loop iteration") 
}

iterablesをループする

のfor-loopをして、のをループすることができます。

val list = listOf("Hello", "World", "!") 
for(str in list) { 
    print(str) 
}

Kotlinのくのものは、のようにりしです

for(i in 0..9) { 
    print(i) 
}

イテレーションにインデックスがな

for((index, element) in iterable.withIndex()) { 
    print("$element at index $index") 
}

forEachをして、なをたずに、ライブラリにまれるへのなアプローチもあります。

iterable.forEach { 
    print(it.toString()) 
}

it 、このでは、に、のをしているラムダを

Whileループ
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whileループとdo-whileループはのとじようにします。

while(condition) { 
    doSomething() 
} 
 
do { 
    doSomething() 
} while (condition)

do-whileループでは、ブロックはループでされたとにアクセスできます。

してする

のとじように、キーワードをしてできます。

while(true) { 
    if(condition1) { 
        continue // Will immediately start the next iteration, without executing the rest of 
the loop body 
    } 
    if(condition2) { 
        break // Will exit the loop completely 
    } 
}

ネストされたループがあるは、ループステートメントにラベルをけ、breakステートメントと
continueステートメントをして、どのループをまたはしたいかをできます。

outer@ for(i in 0..10) { 
    inner@ for(j in 0..10) { 
        break       // Will break the inner loop 
        break@inner // Will break the inner loop 
        break@outer // Will break the outer loop 
    } 
}

しかし、このアプローチはなforEachコンストラクトではしません。

kotlinでをする

//iterates over a map, getting the key and value at once 
 
var map = hashMapOf(1 to "foo", 2 to "bar", 3 to "baz") 
 
for ((key, value) in map) { 
    println("Map[$key] = $value") 
}

ほとんどのプログラミングのように、Kotlinではをしたループもです。

fun factorial(n: Long): Long = if (n == 0) 1 else n * factorial(n - 1) 
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println(factorial(10)) // 3628800

のでは、 factorialは、されたがたされるまでりしびされます。

のための

Kotlinライブラリには、コレクションをりしするためののなもあります。

たとえば、 mapをしてアイテムのリストをすることができます。

val numbers = listOf(1, 2, 3, 4, 5, 6, 7, 8, 9, 0) 
val numberStrings = numbers.map { "Number $it" }

このスタイルのくのの1つは、のでをさせることです。もしのためにのリストをフィルタリングす
るがあったとすれば、ほんのしのしかではありません。 filterをすることができます。

val numbers = listOf(1, 2, 3, 4, 5, 6, 7, 8, 9, 0) 
val numberStrings = numbers.filter { it % 2 == 0 }.map { "Number $it" }

オンラインでKotlinのループをむ https://riptutorial.com/ja/kotlin/topic/2727/kotlinのループ
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9: Kotlinビルドの

Examples

グラデル

kotlin-gradle-pluginは、GradleでKotlinコードをコンパイルするためにされます。に、そのバージ
ョンはするKotlinバージョンにするがあります。たとえば、Kotlin 1.0.3をするは、 kotlin-gradle-
plugin gradle kotlin-gradle-pluginバージョン1.0.3もです。

gradle.propertiesまたはgradle.propertiesこのバージョンをすることをおめし
ExtraPropertiesExtension 。

buildscript { 
   ext.kotlin_version = '1.0.3' 
 
   repositories { 
     mavenCentral() 
   } 
 
   dependencies { 
     classpath "org.jetbrains.kotlin:kotlin-gradle-plugin:$kotlin_version" 
   } 
}

に、このプラグインをプロジェクトにするがあります。これをうは、なるプラットフォームをタ
ーゲットにするときになります。

ターゲティングJVM

apply plugin: 'kotlin'

Androidをターゲットする

apply plugin: 'kotlin-android'

JSのターゲット

apply plugin: 'kotlin2js'

これらはデフォルトのパスです。

コトリンソース src/main/kotlin•

javaソース src/main/java•
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コトリンテスト src/test/kotlin•
java tests src/test/java•
ランタイムリソース src/main/resources•

テストリソース src/test/resources•

カスタムプロジェクトレイアウトをしているは、 SourceSetsをするがあります。

に、プロジェクトにKotlinライブラリのをするがあります

dependencies { 
    compile "org.jetbrains.kotlin:kotlin-stdlib:$kotlin_version" 
}

Kotlin Reflectionをするはcompile "org.jetbrains.kotlin:kotlin-reflect:$kotlin_version"もcompile 

"org.jetbrains.kotlin:kotlin-reflect:$kotlin_version"があります。

Android Studioの

Android Studioでは、AndroidプロジェクトでKotlinをにできます。

プラグインをインストールする

Kotlinプラグインをインストールするには、File> Settings> Editor> Plugins> Install JetBrains 

Plugin ...> Kotlin> Installのにみ、メッセージがされたらAndroid Studioをします。

プロジェクトをする

Android Studioプロジェクトをし、 Ctrl + Shift + Aをします。ボックスに「Kotlin in Project」とし
てEnterをします。

Android StudioはなすべてのをするためにあなたのGradleファイルをします。

Javaの

JavaファイルをKotlinファイルにするには、 Ctrl + Shift + Aをして、「JavaファイルをKotlinファ
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イルに」をします。これにより、のファイルのが.ktにされ、コードがKotlinにされます。

GroovyスクリプトをしてGradleからKotlinスクリプトにする

ステップ

gradle-script-kotlinプロジェクトをする•

されたプロジェクトからプロジェクトにコピー/りけ

build.gradle.kts○

gradlew○

gradlew.bat○

settings.gradle○

•

にじてbuild.gradle.ktsのをすると、クローンされたばかりのプロジェクトのスクリプトや
そのサンプルの1つにインスピレーションをえることができます

•

Intellijをいてプロジェクトをき、エクスプローラウィンドウでGradleプロジェクトとしてさ
れます。そうでないはにします。

•
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いた、Intellijがするようにして、 build.gradle.ktsをき、エラーがないかどうかしてください
。ハイライトがしていない、またはのマークがすべていているは、Intellijをじてきます

•

Gradleウィンドウをき、それをリフレッシュしてください•

Windowsのは、このバグがするがあります。なGradle 3.3ディストリビューションをダウンロー
ドし、されているものをわりにしてください。  。

OSXとUbuntuはすぐにえます。

あなたはすべてのMavenにpublicingのとした、いけたいはのボーナスは、 Jitpackを 、するは、
Groovyのにべ、ほぼじです。こののプロジェクトからインスピレーションをることができます。

オンラインでKotlinビルドのをむ https://riptutorial.com/ja/kotlin/topic/2501/kotlinビルドの
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10: Nullセーフティ

Examples

NullなとNullableでない

Stringようなのはnullではありません。それらにヌルをできるようにするには、 ?それらのにある 
String?

var string        : String = "Hello World!" 
var nullableString: String? = null 
 
string = nullableString    // Compiler error: Can't assign nullable to non-nullable type. 
nullableString = string    // This will work however!

セーフコールオペレータ

nullなのとプロパティにアクセスするには、なをするがあります。

のもの、 ?.アクセスしようとしているプロパティまたはをします。オブジェクトがnullのはnullを
します。

val string: String? = "Hello World!" 
print(string.length)   // Compile error: Can't directly access property of nullable type. 
print(string?.length)  // Will print the string's length, or "null" if the string is null.

イディオムヌルチェックされたじオブジェクトでのメソッドをび
す

ヌルチェックされたオブジェクトののメソッドをびすエレガントなは、Kotlinのapplyようにして
いapply 

obj?.apply { 
    foo() 
    bar() 
}

これは、びしますfooとbarobj あるthisにapplyにのみブロック objそうでないはブロックをスキッ
プし、nullです。

とプロパティのびしののにすることなく、ヌルなをnullableでないとしてスコープにれるには、 
applyわりにletをうことができapply 

nullable?.let { notnull -> 
    notnull.foo() 
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    notnull.bar() 
}

notnullにをける、あるいはりさとをしてすることができ、のラムダパラメータit 。

スマートキャスト

あるでオブジェクトがnullにならないとコンパイラができるは、なをもうするはありません。

var string: String? = "Hello!" 
print(string.length)  // Compile error 
if(string != null) { 
    // The compiler now knows that string can't be null 
    print(string.length)  // It works now! 
}

コンパイラは、nullチェックとされたのでされるがあるスマートキャストのをしません
。

がのブロックのスコープからアクセスできるたとえば、ローカルオブジェクトのメン
バーなので、スマートキャストしてできるしいローカルをするがあります。

Iterableとからのヌルをする

にはをCollection<T?>からCollections<T>にするがあります。その、 filterNotNullがたちのソリュ
ーションです。

val a: List<Int?> = listOf(1, 2, 3, null) 
val b: List<Int> = a.filterNotNull()

Null Coalescing / Elvis Operator

nullなをif-elseのですることがましいことがあります。エルツ、 ?: 、このようなのためにKotlinで
できます。

えば

val value: String = data?.first() ?: "Nothing here."

っての"Nothing here"data?.first()やdataそのものがnullののdata?.first()

じをしてをスローして、コードのをすることもできます。

val value: String = data?.second() 
    ?: throw IllegalArgumentException("Value can't be null!")

アサーションをしてNullPointerExceptionをスローすることができます 
data!!.second()!! 
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アサーション

!!はNULLをし、そののnullのバージョンをします。オブジェクトがnull、 
KotlinNullPointerExceptionがスローされnull 。

val message: String? = null 
println(message!!) //KotlinNullPointerException thrown, app crashes

エルビスオペレーター:)

Kotlinでは、 null referenceをできるをできnull reference 。 nullなaがあるとします。「 aがnullで
ないはそれをし、そうでないはnullのxする」とうことができます

var a: String? = "Nullable String Value"

さて、 aはnullでもかまいません。したがって、 aにアクセスするがある、がまれているかどうか
にわらず、チェックをするがあります。このチェックは、のif...elseステートメントでできます
。

val b: Int = if (a != null) a.length else -1

しかし、ここではオペレータElvis エルビス ?: がる。のif...elseはElvisでのようにすことができ
ます。

val b = a?.length ?: -1

?:ここではa?.length ののがnullでないa?.length 、elvisはそれをします。そうでないは、をここで
は-1 にします。のは、がnullのにのみされます。

オンラインでNullセーフティをむ https://riptutorial.com/ja/kotlin/topic/2080/nullセーフティ
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11: インターフェイス
インタフェースのためのKotlinリファレンスドキュメント インタフェース

Examples

インターフェース

Kotlinインタフェースには、メソッドの、およびをできないデフォルトのメソッドがまれています
。

interface MyInterface { 
    fun bar() 
}

このインターフェイスは、のようにクラスによってできるようになりました。

class Child : MyInterface { 
   override fun bar() { 
       print("bar() was called") 
   } 
}

デフォルトのによるインタフェース

Kotlinのインターフェースは、のデフォルトのをつことができます

interface MyInterface { 
    fun withImplementation() { 
      print("withImplementation() was called") 
    } 
}

そのようなインタフェースをするクラスは、することなくそれらのをすることができます

class MyClass: MyInterface { 
    // No need to reimplement here 
} 
val instance = MyClass() 
instance.withImplementation()

プロパティ

デフォルトのは、プロパティゲッタとセッタにしてもします。

interface MyInterface2 { 
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    val helloWorld 
        get() = "Hello World!" 
}

インターフェイスアクセサではバッキングフィールドをできません

interface MyInterface3 { 
    // this property won't compile! 
    var helloWorld: Int 
        get() = field 
        set(value) { field = value } 
}

の

のインターフェイスがじをしている、またはそれらのすべてが1つのでされている、クラスはなび
しをでするがあります

interface A { 
    fun notImplemented() 
    fun implementedOnlyInA() { print("only A") } 
    fun implementedInBoth() { print("both, A") } 
    fun implementedInOne() { print("implemented in A") } 
} 
 
interface B { 
    fun implementedInBoth() { print("both, B") } 
    fun implementedInOne() // only defined 
} 
 
class MyClass: A, B { 
    override fun notImplemented() { print("Normal implementation") } 
 
    // implementedOnlyInA() can by normally used in instances 
 
    // class needs to define how to use interface functions 
    override fun implementedInBoth() { 
        super<B>.implementedInBoth() 
        super<A>.implementedInBoth() 
    } 
 
    // even if there's only one implementation, there multiple definitions 
    override fun implementedInOne() { 
        super<A>.implementedInOne() 
        print("implementedInOne class implementation") 
    } 
}

インターフェイスのプロパティ

インターフェイスでプロパティをできます。インターフェースはをつことができないので、プロ
パティをとしてするか、またはアクセサのデフォルトをすることによってのみできます。
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interface MyInterface { 
    val property: Int // abstract 
 
    val propertyWithImplementation: String 
        get() = "foo" 
 
    fun foo() { 
        print(property) 
    } 
} 
 
class Child : MyInterface { 
    override val property: Int = 29 
}

デフォルトのでのインタフェースをするの

デフォルトのをむじのメソッドをつのインタフェースをする、どのをするべきかはコンパイラに
とってあいまいです。がした、するメソッドをオーバーライドしてカスタムをするがあります。
このは、デフォルトのにするかどうかをすることができます。

interface FirstTrait { 
    fun foo() { print("first") } 
    fun bar() 
} 
 
interface SecondTrait { 
    fun foo() { print("second") } 
    fun bar() { print("bar") } 
} 
 
class ClassWithConflict : FirstTrait, SecondTrait { 
    override fun foo() { 
        super<FirstTrait>.foo()  // delegate to the default implementation of FirstTrait 
        super<SecondTrait>.foo() // delegate to the default implementation of SecondTrait 
    } 
 
    // function bar() only has a default implementation in one interface and therefore is ok. 
}

スーパーキーワード

interface MyInterface { 
    fun funcOne() { 
        //optional body 
        print("Function with default implementation") 
    } 
}

インタフェースのメソッドがのデフォルトのをっているは、superキーワードをしてそのメソッド
にアクセスできます。

super.funcOne()
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オンラインでインターフェイスをむ https://riptutorial.com/ja/kotlin/topic/900/インターフェイス
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12: クラス

き

Kotlinクラスは、そのインタフェースをするのオブジェクトにメソッドとプロパティをすることに
よって、インタフェースをできます。これにより、ではなくをしてビヘイビアをするがされます
。

Examples

のクラスにメソッドをする

interface Foo { 
    fun example() 
} 
 
class Bar { 
    fun example() { 
        println("Hello, world!") 
    } 
} 
 
class Baz(b : Bar) : Foo by b 
 
Baz(Bar()).example()

このでは、 Hello, world!

オンラインでクラスをむ https://riptutorial.com/ja/kotlin/topic/10575/クラス
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13: クラス

き

どんなオブジェクトプログラミングでも、あるのクラスがあります。にさせてください

あなたがフルーツのをプログラムしなければならないとしてください Apples 、 OrangesとPears 。
らはすべてサイズ、、がなります。そのため、たちはなるクラスをっています。

しかし、らのいがでもではないといましょう。にはなく、 Fruitほしいとっていますか getFruit()

はどのようなりがありますか

えはクラスFruitです。たちはしいクラスをり、それからすべてのをします

オープン{ベースクラス}•
class {クラス}{クラス}{Init Arguments}•

override {の}•

{DC-Object}は{Base Class}です== true•

パラメーター

パラメータ

ベースクラス のクラス

クラス ベースクラスからするクラス

Init クラスのコンストラクタにされる

クラスのコードとなるコードをつクラスの

DCオブジェクト クラスのをつ「クラスオブジェクト」オブジェクト

Examples

'open'キーワード

Kotlinでは、クラスはデフォルトでです 。つまり、クラスはできません。

クラスのをするには、 openキーワードをしopen 。

open class Thing { 
    // I can now be extended! 

https://riptutorial.com/ja/home 42



}

クラス、クラス、およびインタフェースは、デフォルトでopenれます。

クラスからフィールドをする

クラスの

open class BaseClass { 
    val x = 10 
}

クラスの

class DerivedClass: BaseClass() { 
    fun foo() { 
        println("x is equal to " + x) 
    } 
}

サブクラスの

fun main(args: Array<String>) { 
    val derivedClass = DerivedClass() 
    derivedClass.foo() // prints: 'x is equal to 10' 
}

クラスからメソッドをする

クラスの

open class Person { 
    fun jump() { 
        println("Jumping...") 
    } 
}

クラスの

class Ninja: Person() { 
    fun sneak() { 
        println("Sneaking around...") 
    } 
}

はPersonのすべてのメソッドにアクセスできます
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fun main(args: Array<String>) { 
    val ninja = Ninja() 
    ninja.jump()  // prints: 'Jumping...' 
    ninja.sneak() // prints: 'Sneaking around...' 
}

プロパティとメソッドのオーバーライド

プロパティのオーバーライドみりとの

abstract class Car { 
    abstract val name: String; 
    open var speed: Int = 0; 
} 
 
class BrokenCar(override val name: String) : Car() { 
    override var speed: Int 
        get() = 0 
        set(value) { 
            throw UnsupportedOperationException("The car is bloken") 
        } 
} 
 
fun main(args: Array<String>) { 
    val car: Car = BrokenCar("Lada") 
    car.speed = 10 
}

メソッドのオーバーライド

interface Ship { 
    fun sail() 
    fun sink() 
} 
 
object Titanic : Ship { 
 
    var canSail = true 
 
    override fun sail() { 
        sink() 
    } 
 
    override fun sink() { 
        canSail = false 
    } 
}

オンラインでクラスをむ https://riptutorial.com/ja/kotlin/topic/5622/クラス

https://riptutorial.com/ja/home 44

https://riptutorial.com/ja/kotlin/topic/5622/%E3%82%AF%E3%83%A9%E3%82%B9%E7%B6%99%E6%89%BF
https://riptutorial.com/ja/kotlin/topic/5622/%E3%82%AF%E3%83%A9%E3%82%B9%E7%B6%99%E6%89%BF
https://riptutorial.com/ja/kotlin/topic/5622/%E3%82%AF%E3%83%A9%E3%82%B9%E7%B6%99%E6%89%BF
https://riptutorial.com/ja/kotlin/topic/5622/%E3%82%AF%E3%83%A9%E3%82%B9%E7%B6%99%E6%89%BF


14: コトリンにログインする
する Kotlinにログインするな

Examples

kotlin.logging

class FooWithLogging { 
  companion object: KLogging() 
 
  fun bar() { 
    logger.info { "hello $name" } 
  } 
 
  fun logException(e: Exception) { 
    logger.error(e) { "Error occured" } 
  } 
}

kotlin.loggingフレームワークの

オンラインでコトリンにログインするをむ https://riptutorial.com/ja/kotlin/topic/3258/コトリンにロ
グインする
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15: コトリンの

き

このトピックでは、けのKotlinのについてします。

Kotlinファイルのは.ktです。1. 

Kotlinのすべてのクラスには、のスーパークラスAnyがあります。これは、スーパータイプ
がされていないクラスJavaのObjectにていますのデフォルトのスーパーです。

2. 

はvalimmutable- assign onceまたはvarmutables- valueはとしてできます。3. 

ステートメントのにセミコロンはありません。4. 
がなをさない、そのりのはUnitです。これもオプションです。 6.は===によってチェックさ
れます。 a === bは、aとbがじオブジェクトをしているにのみとされます。

5. 

Examples

な

1.ユニットりは、ではオプションです。のコードはです。

    fun printHello(name: String?): Unit { 
        if (name != null) 
            println("Hello ${name}") 
    } 
 
    fun printHello(name: String?) { 
        ... 
    }

2.Single-Expressionがのをすとき、はでき、bodyは= symbolのにされます

  fun double(x: Int): Int = x * 2

これがコンパイラによってできる、りのをにすることはオプションです

  fun double(x: Int) = x * 2

3.をうのはです。

In java: 
    int num=10 
    String s  = "i =" + i; 
 
In Kotlin 
    val num = 10 
    val s = "i = $num"
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4.In Kotlinでは、システムは、nullnullableをできると、nullのできないをします。たとえば、
Stringののはnullをできません。

var a: String = "abc" 
a = null // compilation error

nullをするには、をnullなとしてすることができます。

var b: String? = "abc" 
b = null // ok

5.In Kotlinでは、==はにのしいかどうかをチェックします。では、a == bのようなはのようにされ
ます。

   a?.equals(b) ?: (b === null)

オンラインでコトリンのをむ https://riptutorial.com/ja/kotlin/topic/10648/コトリンの
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16: コトリン

Examples

nullなにしてtoStringをびす

KotlinでtoStringメソッドをするときにすべきは、 String?とみわせてnullをすることString? 。

たとえば、AndroidのEditTextからテキストをしたいとします。

のようなコードがあります。

// Incorrect: 
val text = view.textField?.text.toString() ?: ""

フィールドがしない、はのになりますが、このは"null"ます。

// Correct: 
val text = view.textField?.text?.toString() ?: ""

オンラインでコトリンをむ https://riptutorial.com/ja/kotlin/topic/6608/コトリン
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17: コルーチン

き

コトルのコルーチンのまだの

Examples

ブロックではなく1れたシンプルなコルーチン

から

fun main(args: Array<String>) { 
    launch(CommonPool) { // create new coroutine in common thread pool 
        delay(1000L) // non-blocking delay for 1 second (default time unit is ms) 
        println("World!") // print after delay 
    } 
    println("Hello,") // main function continues while coroutine is delayed 
    Thread.sleep(2000L) // block main thread for 2 seconds to keep JVM alive 
}

Hello, 
World!

オンラインでコルーチンをむ https://riptutorial.com/ja/kotlin/topic/10936/コルーチン
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18: コレクション

き

くのとはなり、Kotlinはなコレクションとなコレクションリスト、セット、マップなどをします。
コレクションをいつできるかをにすることは、バグをしたり、れたAPIをするのにちます。

listOf、mapOfおよびsetOfは、アイテムをまたはできないみりオブジェクトをします。•

をまたはするは、arrayListOf、hashMapOf、hashSetOf、linkedMapOfLinkedHashMap、
linkedSetOfLinkedHashSet、mutableListOfKotlin MultableListコレクション、mutableMapOf
Kotlin MultableMapコレクション、mutableSetOfKotlin MultibleSetコレクション、
sortedMapOfまたはsortedSetOf

•

コレクションには、first、last、get、filter、map、join、reduceなどのラムダなどのメソッド
があります。

•

Examples

リストをう

// Create a new read-only List<String> 
val list = listOf("Item 1", "Item 2", "Item 3") 
println(list) // prints "[Item 1, Item 2, Item 3]"

マップの

// Create a new read-only Map<Integer, String> 
val map = mapOf(Pair(1, "Item 1"), Pair(2, "Item 2"), Pair(3, "Item 3")) 
println(map) // prints "{1=Item 1, 2=Item 2, 3=Item 3}"

セットをう

// Create a new read-only Set<String> 
val set = setOf(1, 3, 5) 
println(set) // prints "[1, 3, 5]"

オンラインでコレクションをむ https://riptutorial.com/ja/kotlin/topic/8846/コレクション
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19: ジェネリックス

き

リストには、、、またはにかをすることができます。だからたちはリストをとんでいます。

ジェネリックスは、には、クラスができるとオブジェクトがしているをするためにされます。

クラスClassName < TypeName >•

クラスClassName <*>•
ClassName <in UpperBound >•
ClassName <out LowerBound >•
クラス < TypeName  UpperBound >•

パラメーター

パラメータ

TypeName タイプパラメータの

LowerBound コントラバナント

クラス クラスの

するはNullableです
Kotlinジェネリックスでは、パラメータTはAny? 。したがって、このクラスの

class Consumer<T>

パラメータTはにT: Any? 。nullのをるには、にのT: Anyをいます。えば

class Consumer<T: Any>

Examples

サイトの

サイトのは、サイトののとみなすことができます。
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  class Consumer<in T> { fun consume(t: T) { ... } } 
 
  fun charSequencesConsumer() : Consumer<CharSequence>() = ... 
 
  val stringConsumer : Consumer<String> = charSequenceConsumer() // OK since in-projection 
  val anyConsumer : Consumer<Any> = charSequenceConsumer() // Error, Any cannot be passed 
 
  val outConsumer : Consumer<out CharSequence> = ... // Error, T is `in`-parameter

サイトののなは、 List<out T>であり、これはTがりのとしてのみれるようにであり、 
Comparator<in T>はとしてTをけるだけです。

サイト

サイトのは、Javaワイルドカードにています。

アウトプロジェクション

  val takeList : MutableList<out SomeType> = ... // Java: List<? extends SomeType> 
 
  val takenValue : SomeType = takeList[0] // OK, since upper bound is SomeType 
 
  takeList.add(takenValue) // Error, lower bound for generic is not specified

インプロジェクション

  val putList : MutableList<in SomeType> = ... // Java: List<? super SomeType> 
 
  val valueToPut : SomeType = ... 
  putList.add(valueToPut) // OK, since lower bound is SomeType 
 
  putList[0] // This expression has type Any, since no upper bound is specified

  val starList : MutableList<*> = ... // Java: List<?> 
 
  starList[0] // This expression has type Any, since no upper bound is specified 
  starList.add(someValue) // Error, lower bound for generic is not specified

Variant JavaからKotlinをびすときの。•

オンラインでジェネリックスをむ https://riptutorial.com/ja/kotlin/topic/1147/ジェネリックス
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20: シングルトンオブジェクト

き

オブジェクトはなのクラスで、 objectキーワードをしてすることができます。オブジェクトは
JavaのSingletonデザインパターンにています。これはjavaのなとしてもします。 Javaからkotlin

にりえるは、な、またはシングルトンのわりに、このをにできます。

Examples

Javaのメソッド/フィールドのrepalcementとして

object CommonUtils { 
 
    var anyname: String ="Hello" 
 
    fun dispMsg(message: String) { 
        println(message) 
    } 
}

のクラスから、とをこのようにびすだけです

CommonUtils.anyname 
CommonUtils.dispMsg("like static call")

シングルトンとしてする

にはKotlinオブジェクトはなるシングルトンです。そのなは、シングルトンのインスタンスをする
ためにSomeSingleton.INSTANCEをするがないことです。

javaでは、シングルトンはのようになります。

public enum SharedRegistry { 
    INSTANCE; 
    public void register(String key, Object thing) {} 
} 
 
public static void main(String[] args) { 
    SharedRegistry.INSTANCE.register("a", "apple"); 
    SharedRegistry.INSTANCE.register("b", "boy"); 
    SharedRegistry.INSTANCE.register("c", "cat"); 
    SharedRegistry.INSTANCE.register("d", "dog"); 
}

kotlinでは、コードはのようになります。
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object SharedRegistry { 
    fun register(key: String, thing: Object) {} 
} 
 
fun main(Array<String> args) { 
    SharedRegistry.register("a", "apple") 
    SharedRegistry.register("b", "boy") 
    SharedRegistry.register("c", "cat") 
    SharedRegistry.register("d", "dog") 
}

それはobvoiuslyあまりなすることです。

オンラインでシングルトンオブジェクトをむ https://riptutorial.com/ja/kotlin/topic/10152/シングル
トンオブジェクト
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21: タイプエイリアス

き

エイリアスでは、のにエイリアスをけることができます。これは、 (String) -> Booleanや
Pair<Person, Person>ようなのようなにをけるのにです。

タイプエイリアスはジェネリックをサポートします。エイリアスはタイプをジェネリックにきえ
ることができ、エイリアスはジェネリックにすることができます。

タイプアリアス エイリアス = タイプ•

エイリアスはコンパイラのです。 JVMのコードにはもされません。すべてのエイリアスはにきえ
られます。

Examples

typealias StringValidator = (String) -> Boolean 
typealias Reductor<T, U, V> = (T, U) -> V

タイプ

typealias Parents = Pair<Person, Person> 
typealias Accounts = List<Account>

オンラインでタイプエイリアスをむ https://riptutorial.com/ja/kotlin/topic/9453/タイプエイリアス

https://riptutorial.com/ja/home 55

https://riptutorial.com/ja/kotlin/topic/9453/%E3%82%BF%E3%82%A4%E3%83%97%E3%82%A8%E3%82%A4%E3%83%AA%E3%82%A2%E3%82%B9
https://riptutorial.com/ja/kotlin/topic/9453/%E3%82%BF%E3%82%A4%E3%83%97%E3%82%A8%E3%82%A4%E3%83%AA%E3%82%A2%E3%82%B9


22: タイプセーフビルダ
タイプセーフなビルダーは、ではなくコンセプトなので、にされていません。

タイプセーフなビルダーのな

のビルダーは、3つのステップでされます。

オブジェクトをします。1. 
ラムダをしてオブジェクトをします。2. 
するオブジェクトをするかす。3. 

Kotlinライブラリのされたビルダー

タイプセーフなビルダーのコンセプトは、Kotlinのライブラリやフレームワークでくわれています
。

アンコ•
わさび•
Ktor•

•

Examples

なツリービルダ

ビルダーは、をとするラムダをるのセットとしてできます。このでは、 JFrameメニューがされて
います

import javax.swing.* 
 
fun JFrame.menuBar(init: JMenuBar.() -> Unit) { 
    val menuBar = JMenuBar() 
    menuBar.init() 
    setJMenuBar(menuBar) 
} 
 
fun JMenuBar.menu(caption: String, init: JMenu.() -> Unit) { 
    val menu = JMenu(caption) 
    menu.init() 
    add(menu) 
} 
 
fun JMenu.menuItem(caption: String, init: JMenuItem.() -> Unit) { 
    val menuItem = JMenuItem(caption) 
    menuItem.init() 
    add(menuItem) 
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}

これらのをすると、オブジェクトのツリーをにできます。

class MyFrame : JFrame() { 
    init { 
        menuBar { 
            menu("Menu1") { 
                menuItem("Item1") { 
                    // Initialize MenuItem with some Action 
                } 
                menuItem("Item2") {} 
            } 
            menu("Menu2") { 
                menuItem("Item3") {} 
                menuItem("Item4") {} 
            } 
        } 
    } 
}

オンラインでタイプセーフビルダをむ https://riptutorial.com/ja/kotlin/topic/6010/タイプセーフビル
ダ
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23: レンジ

き

は、inとinでされるの..をつrangeToでされます。はすべてのなにしてされますが、のプリミティ
ブではされたがあります

Examples

の

インテグラルのIntRange、LongRange、CharRangeにはながあります。それらはがです。コンパ
イラはこれを、Javaのインデックスきfor-loopとに、なオーバーヘッドなしにします

for (i in 1..4) print(i) // prints "1234" 
for (i in 4..1) print(i) // prints nothing

downTo

をにりしたいはそれはです。ライブラリでされたdownToをすることができます

for (i in 4 downTo 1) print(i) // prints "4321"

step

のステップでをすることはですか1にしくはありませんかもちろん、stepはあなたにちます

for (i in 1..4 step 2) print(i) // prints "13" 
for (i in 4 downTo 1 step 2) print(i) // prints "42"

まで

endをまないをするには、untilをします。

for (i in 1 until 10) { // i in [1, 10), 10 is excluded 
println(i) 
}

オンラインでレンジをむ https://riptutorial.com/ja/kotlin/topic/10121/レンジ
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24: 

Examples

try-catch-finallyをってをキャッチする

KotlinのをキャッチするのはJavaとによくています

try { 
    doSomething() 
} 
catch(e: MyException) { 
    handle(e) 
} 
finally { 
    cleanup() 
}

のをキャッチすることもできます

try { 
    doSomething() 
} 
catch(e: FileSystemException) { 
    handle(e) 
} 
catch(e: NetworkException) { 
    handle(e) 
} 
catch(e: MemoryException) { 
    handle(e) 
} 
finally { 
    cleanup() 
} 

tryもであり、をすがあります

val s: String? = try { getString() } catch (e: Exception) { null }

Kotlinはをチェックしていないので、をキャッチするはありません。

fun fileToString(file: File) : String { 
    //readAllBytes throws IOException, but we can omit catching it 
    fileContent = Files.readAllBytes(file) 
    return String(fileContent) 
}

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/7246/
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25: 

Javaのとに、Kotlinのenumクラスは、されたenumをリストし、そのでをることをにするメソッ
ドをっています。これらのメソッドのシグネチャはのとおりですenumクラスのがEnumClassと
EnumClass 。

EnumClass.valueOf(value: String): EnumClass 
EnumClass.values(): Array<EnumClass>

されたがクラスでされているのいずれともしない、 valueOf()メソッドはIllegalArgumentException

スローします。

すべてのenumには、enumクラスのとをするためのプロパティがあります。

val name: String 
val ordinal: Int

enumは、Comparableインタフェースもしています。は、enumクラスでされているです。

Examples

のクラスとじようにEnumクラスはコンストラクタをち、されます

enum class Color(val rgb: Int) { 
    RED(0xFF0000), 
    GREEN(0x00FF00), 
    BLUE(0x0000FF) 
}

enumsのとプロパティ

クラスはメンバつまり、プロパティとをすることもできます。のenumオブジェクトとのメンバー
のにセミコロン ; をするがあります。

メンバーがabstract、enumオブジェクトはそれをするがあります。

enum class Color { 
    RED { 
        override val rgb: Int = 0xFF0000 
    }, 
    GREEN { 
        override val rgb: Int = 0x00FF00 
    }, 
    BLUE { 
        override val rgb: Int = 0x0000FF 
    } 
 
    ; 
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    abstract val rgb: Int 
 
    fun colorString() = "#%06X".format(0xFFFFFF and rgb) 
}

なenum

enum class Color { 
  RED, GREEN, BLUE 
}

enumはオブジェクトです。 Enumはコンマでられています。

はですが、これはシングルトンのをするのです。

enum class Planet(var population: Int = 0) { 
    EARTH(7 * 100000000), 
    MARS(); 
 
    override fun toString() = "$name[population=$population]" 
} 
 
 println(Planet.MARS) // MARS[population=0] 
 Planet.MARS.population = 3 
 println(Planet.MARS) // MARS[population=3]

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/2286/
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26: 

き

リフレクションとは、コンパイルではなくにコードをするのです。

リフレクションは、にクラスおよびをイントロスペクションするためのメカニズムです。

JVMプラットフォームをとする、リフレクションは々のJAR kotlin-reflect.jarます。これはのサ
イズをらし、のをカットし、のJSのようなプラットフォームをターゲットにすることをにするた
めにわれます。

Examples

クラスの

いくつかのクラスをすKClassオブジェクトへのをするには、コロンをします。

val c1 = String::class 
val c2 = MyClass::class

の

はKotlinのです。コロンをしてをし、のにすことができます。

fun isPositive(x: Int) = x > 0 
 
val numbers = listOf(-2, -1, 0, 1, 2) 
println(numbers.filter(::isPositive)) // [1, 2]

Javaリフレクションとの

KotlinのKClassからJavaのClassオブジェクトをするには、 .javaプロパティをします。

val stringKClass: KClass<String> = String::class 
val c1: Class<String> = stringKClass.java 
 
val c2: Class<MyClass> = MyClass::class.java

のは、のKClassインスタンスをりてないようにコンパイラによってされます。

クラスのすべてのプロパティのをする

えられたExampleクラスBaseExampleいくつかのプロパティをつクラスを
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open class BaseExample(val baseField: String) 
 
class Example(val field1: String, val field2: Int, baseField: String): 
    BaseExample(baseField) { 
 
    val field3: String 
        get() = "Property without backing field" 
 
    val field4 by lazy { "Delegated value" } 
 
    private val privateField: String = "Private value" 
}

クラスのすべてのプロパティをすることができます

val example = Example(field1 = "abc", field2 = 1, baseField = "someText") 
 
example::class.memberProperties.forEach { member -> 
    println("${member.name} -> ${member.get(example)}") 
}

このコードをすると、がスローされます。プロパティprivate val privateFieldはprivateとされ、
そのでmember.get(example)をびすとしません。これをしてプライベートプロパティをする1つの。
これをうには、プロパティのJavaゲッターのをチェックするがあります。 private valの、getter
はしないため、プライベートアクセスがです。

ヘルパーとそのはのようになります

fun isFieldAccessible(property: KProperty1<*, *>): Boolean { 
    return property.javaGetter?.modifiers?.let { !Modifier.isPrivate(it) } ?: false 
} 
 
val example = Example(field1 = "abc", field2 = 1, baseField = "someText") 
 
example::class.memberProperties.filter { isFieldAccessible(it) }.forEach { member -> 
    println("${member.name} -> ${member.get(example)}") 
}

のアプローチは、リフレクションをしてプライベートプロパティにアクセスできるようにするこ
とです。

example::class.memberProperties.forEach { member -> 
    member.isAccessible = true 
    println("${member.name} -> ${member.get(example)}") 
}

クラスのすべてのプロパティのをする

として、サンプルクラスのすべてのプロパティをする

class TestClass { 
    val readOnlyProperty: String 
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        get() = "Read only!" 
 
    var readWriteString = "asd" 
    var readWriteInt = 23 
 
    var readWriteBackedStringProperty: String = "" 
        get() = field + '5' 
        set(value) { field = value + '5' } 
 
    var readWriteBackedIntProperty: Int = 0 
        get() = field + 1 
        set(value) { field = value - 1 } 
 
    var delegatedProperty: Int by TestDelegate() 
 
    private var privateProperty = "This should be private" 
 
    private class TestDelegate { 
        private var backingField = 3 
 
        operator fun getValue(thisRef: Any?, prop: KProperty<*>): Int { 
            return backingField 
        } 
 
        operator fun setValue(thisRef: Any?, prop: KProperty<*>, value: Int) { 
            backingField += value 
        } 
    } 
}

なプロパティをするには、すべてのプロパティをし、なプロパティをタイプにフィルタリングし
ます。プライベートプロパティをみるとがするため、もチェックするがあります。

val instance = TestClass() 
TestClass::class.memberProperties 
        .filter{ prop.visibility == KVisibility.PUBLIC } 
        .filterIsInstance<KMutableProperty<*>>() 
        .forEach { prop -> 
            System.out.println("${prop.name} -> ${prop.get(instance)") 
        }

すべてのStringプロパティを"Our Value"にするには、りのでさらにフィルタリングできます。 
KotlinはJava VMをベースにしているため、 タイプがなので、 List<String>などのタイプをすプロ
パティはList<Any>とじになります。ながら、はのではなく、これをけるためのなはないので、あ
なたのでするがあります。

val instance = TestClass() 
TestClass::class.memberProperties 
        .filter{ prop.visibility == KVisibility.PUBLIC } 
        // We only want strings 
        .filter{ it.returnType.isSubtypeOf(String::class.starProjectedType) } 
        .filterIsInstance<KMutableProperty<*>>() 
        .forEach { prop -> 
            // Instead of printing the property we set it to some value 
            prop.setter.call(instance, "Our Value") 
        }
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オンラインでをむ https://riptutorial.com/ja/kotlin/topic/2402/
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27: 

き

Kotlinには、4のがあります。

これはどこからでもアクセスできます。

これはモジュールコードからのみアクセスできます。

Protectedこれは、それをするクラスとのクラスからのみアクセスできます。

これはそれをするクラスのスコープからのみアクセスできます。

<visibility modifier> val/var <variable name> = <value>•

Examples

コードサンプル

パブリック public val name = "Avijit"

プライベート private val name = "Avijit"

された protected val name = "Avijit"

internal val name = "Avijit"

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/10019/
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28: なラムダ
なパラメータ•

{parameterNameParameterType、otherParameterNameOtherParameterType - > 
anExpression}

•

されるパラメータ•

Int、Int - > Int = {a、b - > a + b}•

のパラメータは、 itします。•

val squareInt - > Int = {it * it}•

•

- > ResultType•

InputType - > ResultType•

InputType1、InputType2 - > ResultType•

のパラメータは、コンテキストからできるときにすることができます。たとえば、をとるクラス
のがあるとします。

data class User(val fistName: String, val lastName: String) { 
    fun username(userNameGenerator: (String, String) -> String) = 
        userNameGenerator(firstName, secondName) 
}

ラムダをすことによってこのをすることができます。パラメータはすでにシグネチャでされてい
るため、ラムダでパラメータをするはありません。

val user = User("foo", "bar") 
println(user.userName { firstName, secondName -> 
     "${firstName.toUppercase}"_"${secondName.toUppercase}" 
 }) // prints FOO_BAR

これは、ラムダをにするにもされます。

//valid: 
val addition: (Int, Int) = { a, b -> a + b } 
//valid: 
val addition = { a: Int, b: Int -> a + b } 
//error (type inference failure): 
val addition = { a, b -> a + b }

ラムダは、つのパラメータをり、はからできるは、のでパラメータをすることができit 。
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listOf(1,2,3).map { it * 2 } // [2,4,6]

Examples

をフィルタリングするパラメータとしてのLambda

val allowedUsers = users.filter { it.age > MINIMUM_AGE }

ラムダはとしてされる

val isOfAllowedAge = { user: User -> user.age > MINIMUM_AGE } 
val allowedUsers = users.filter(isOfAllowedAge)

びしをベンチマークするためのLambda

のにするをするストップウォッチ

object Benchmark { 
    fun realtime(body: () -> Unit): Duration { 
        val start = Instant.now() 
        try { 
            body() 
        } finally { 
            val end = Instant.now() 
            return Duration.between(start, end) 
        } 
    } 
}

val time = Benchmark.realtime({ 
    // some long-running code goes here ... 
}) 
println("Executed the code in $time")

オンラインでなラムダをむ https://riptutorial.com/ja/kotlin/topic/5878/なラムダ
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29: されたプロパティ

き

Kotlinはプロパティのをハンドラオブジェクトにできます。やなプロパティなど、いくつかのハン
ドラがまれています。カスタムハンドラもできます。

Examples

い

val foo : Int by lazy { 1 + 1 } 
println(foo)

このでは、 2されます。

な

var foo : Int by Delegates.observable("1") { property, oldValue, newValue -> 
    println("${property.name} was changed from $oldValue to $newValue") 
} 
foo = 2

foo was changed from 1 to 2

にづくプロパティ

val map = mapOf("foo" to 1) 
val foo : String by map 
println(foo)

このでは、 1

カスタム

class MyDelegate { 
    operator fun getValue(owner: Any?, property: KProperty<*>): String { 
        return "Delegated value" 
    } 
} 
 
val foo : String by MyDelegate() 
println(foo)

このでは、 Delegated valueしDelegated value
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デリゲートをらすためのレイヤーとしてできます。

KotlinのNullシステムとWeakReference<T>えてみましょう。

だから、らかのリファレンスをしなければならないとしましょう。メモリリークをけたいのです
が、 WeakReferenceがどこにるかはここです。

たとえばこれをる

class MyMemoryExpensiveClass { 
    companion object { 
        var reference: WeakReference<MyMemoryExpensiveClass>? = null 
 
        fun doWithReference(block: (MyMemoryExpensiveClass) -> Unit) { 
            reference?.let { 
                it.get()?.let(block) 
            } 
        } 
    } 
 
    init { 
        reference = WeakReference(this) 
    } 
}

これは1つのWeakReferenceだけです。このボイラープレートをらすために、カスタムプロパテ
ィデリゲートをして、のようにすることができます。

class WeakReferenceDelegate<T>(initialValue: T? = null) : ReadWriteProperty<Any, T?> { 
    var reference = WeakReference(initialValue) 
        private set 
 
    override fun getValue(thisRef: Any, property: KProperty<*>): T? = reference.get() 
 
    override fun setValue(thisRef: Any, property: KProperty<*>, value: T?) { 
        reference = WeakReference(value) 
    } 
}

これで、 WeakReferenceラップされたを、のnullableとにできます。

class MyMemoryExpensiveClass { 
    companion object { 
        var reference: MyMemoryExpensiveClass? by 
WeakReferenceDelegate<MyMemoryExpensiveClass>() 
 
        fun doWithReference(block: (MyMemoryExpensiveClass) -> Unit) { 
            reference?.let(block) 
        } 
    } 
 
    init { 
        reference = this 
    } 
}
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オンラインでされたプロパティをむ https://riptutorial.com/ja/kotlin/topic/10571/されたプロパティ
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30: 

Examples

DTOのPOJO / POCO

kotlinのデータクラスは、データをするだけでするためにされたクラスです。そのようなクラスは
dataとしてマークされdata 

data class User(var firstname: String, var lastname: String, var age: Int)

のコードはUserクラスをし、のコードをにします

すべてのプロパティのゲッターとセッター valのゲッターのみ•
equals()•
hashcode()•
toString()•
copy()•

componentN()  Nはのにするプロパティ•

とに、デフォルトもできます。

data class User(var firstname: String = "Joe", var lastname: String = "Bloggs", var age: Int = 
20)

は、ここでデータクラスをしてください。

リストのフィルタリング

val list = listOf(1,2,3,4,5,6) 
 
//filter out even numbers 
 
val even = list.filter { it % 2 == 0 } 
 
println(even) //returns [2,4]

のコンストラクタでクラスをせずにクラスにする

あるクラスにしたいが、コンストラクターパラメーターにdelegated-toクラスをしたくないとしま
す。わりに、それをにして、コンストラクタのびしにそれをらさないようにしたいとします。は
、クラスでコンストラクタパラメータのみをできるため、これはにえるかもしれません。しかし
、 このえにあるように、それをうがあります 

class MyTable private constructor(table: Table<Int, Int, Int>) : Table<Int, Int, Int> by table 
{ 
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    constructor() : this(TreeBasedTable.create()) // or a different type of table if desired 
 
}

これでMyTableのコンストラクタをMyTable()ようにびすことができます。 MyTableするTable<Int, 

Int, Int> 、にされます。コンストラクターのびしはもらない。

このはこのSOのにづいています。

KotlinのSerializableとserialVersionUid

KotlinでクラスのserialVersionUIDをするには、クラスのコンパニオンオブジェクトにメンバーを
するといういくつかのオプションがあります。

もなバイトコードは、するクラスこのはMySpecialCaseプライベートになるprivate const valから
MySpecialCaseます。

class MySpecialCase : Serializable { 
    companion object { 
        private const val serialVersionUID: Long = 123 
    } 
}

これらのフォームをすることもできます。これらのフォームはそれぞれのためにでないゲッター
/セッターメソッドをつというをいます。

class MySpecialCase : Serializable { 
    companion object { 
        private val serialVersionUID: Long = 123 
    } 
}

これにより、フィールドがされますが、 getSerialVersionUIDもなコンパニオンオブジェクトにさ
れます。

class MySpecialCase : Serializable { 
    companion object { 
        @JvmStatic private val serialVersionUID: Long = 123 
    } 
} 

これにより、フィールドがされますが、ゲッターとgetSerialVersionUIDがまれているクラス
MySpecialCaseにもですがされます。

しかし、すべてはserialVersionUIDをSerializableクラスにするとしてします。

Kotlinのなメソッド
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Kotlinのなメソッドは、Javaとじにすることができます

fun doSomething() { 
   someOtherAction() 
   return this 
}

ただし、のようなをすることで、よりにすることもできます。

fun <T: Any> T.fluently(func: ()->Unit): T { 
    func() 
    return this 
}

よりななをにする

fun doSomething() { 
   return fluently { someOtherAction() } 
}

letをするか、ヌルオブジェクトのをする

let Kotlinにそれはにびされたオブジェクトからバインディングローカルをします。

val str = "foo" 
str.let { 
    println(it) // it 
} 

これは"foo" 、 Unitをします。

いletとalsoあなたからのをすことができるということであるletブロック。 also 、ではにUnitを
reutrnします。

なぜこれがなのですか nullをすことができるメソッドをびすと、そのりがnullでないにのみいく
つかのコードをしたい、 letをうlet alsoできますlet 、のようにすることalsoできます

val str: String? = someFun() 
str?.let { 
    println(it) 
}

このコードは、 strがnullでないにのみletブロックをしnull 。 null ? にしてください。

をしてオブジェクトをするか、メソッドをする

applyのには、のようにapplyています。

されたブロックをびしthis 、そののようなをすとthisは。
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KDOCはそれほどではありませんがapplyかになです。のではapplyれるをthisあなたがばれるオブ
ジェクトにバインドされているapplyを。これにより、あるオブジェクトにしてのメソッドをびす
がじたときに、そのオブジェクトをですときにいくつかのコードをすることができます。

File(dir).apply { mkdirs() }

これはこれをいているのとじです

fun makeDir(String path): File { 
    val result = new File(path) 
    result.mkdirs() 
    return result 
}

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/2273/
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31: メソッド
fun TypeName.extensionNameparams、...{/ * body * /} //•

あなたはジェネリックスをってすることができます。<T> Any> TypeNameWithGenerics 

<T> .extensionNameparams、...{/ * body * /} // Generics

•

myObj.extensionNameargs、...//びし•

はにされます。つまり、するメソッドは、アクセスするのによってまります。にのがであるかは
ありません。じメソッドがにびされます。これは、メソッドをしても、にはタイプにメンバーが
されないためです。

Examples

トップレベルの

のメソッドは、クラスにはまれていません。

fun IntArray.addTo(dest: IntArray) { 
    for (i in 0 .. size - 1) { 
        dest[i] += this[i] 
    } 
}

のメソッドは、 IntArrayIntArrayされています。メソッドがされているオブジェクト とばれるに
は、キーワードthisをしてアクセスすることにしてください。

このはのようにびすことができます

val myArray = intArrayOf(1, 2, 3) 
intArrayOf(4, 5, 6).addTo(myArray)

なとしがにされる

びされるメソッドは、アクセスされるのにづいてコンパイルにされます。にのがであるかはあり
ません。じメソッドがにびされます。

open class Super 
 
class Sub : Super() 
 
fun Super.myExtension() = "Defined for Super" 
 
fun Sub.myExtension() = "Defined for Sub" 
 
fun callMyExtension(myVar: Super) { 
    println(myVar.myExtension()) 
} 
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callMyExtension(Sub())

のでは、され"Defined for Super"のされたため、 myVarあるSuper 。

がめるをレンダリングするためにくびるサンプル

がめるをするために、 IntまたはLongのがあれば、

fun Long.humanReadable(): String { 
    if (this <= 0) return "0" 
    val units = arrayOf("B", "KB", "MB", "GB", "TB", "EB") 
    val digitGroups = (Math.log10(this.toDouble())/Math.log10(1024.0)).toInt(); 
    return DecimalFormat("#,##0.#").format(this/Math.pow(1024.0, digitGroups.toDouble())) + " 
" + units[digitGroups]; 
} 
 
fun Int.humanReadable(): String { 
    return this.toLong().humanReadable() 
}

ににされます

println(1999549L.humanReadable()) 
println(someInt.humanReadable())

サンプルJava 7+パスクラスの

メソッドのなは、のAPIをすることです。 Java 7+ Pathクラスにexist 、 notExists 、および
deleteRecursivelyをexistをにします。

fun Path.exists(): Boolean = Files.exists(this) 
fun Path.notExists(): Boolean = !this.exists() 
fun Path.deleteRecursively(): Boolean = this.toFile().deleteRecursively()

このでこれをびすことができます

val dir = Paths.get(dirName) 
if (dir.exists()) dir.deleteRecursively()

をしてみやすくする

Kotlinではのようなコードをくことができます

val x: Path = Paths.get("dirName").apply { 
    if (Files.notExists(this)) throw IllegalStateException("The important file does not 
exist") 
}
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しかし、 applyのは、あなたのとじくらいではありません。アクションのをしてよりなものにする
ために、のをすることが々になります。これはのかないようにすべきではありませんが、のよう
なになのために

infix inline fun <T> T.verifiedBy(verifyWith: (T) -> Unit): T { 
    verifyWith(this) 
    return this 
} 
 
infix inline fun <T: Any> T.verifiedWith(verifyWith: T.() -> Unit): T { 
    this.verifyWith() 
    return this 
}

コードをのようにくことができます

val x: Path = Paths.get("dirName") verifiedWith { 
    if (Files.notExists(this)) throw IllegalStateException("The important file does not 
exist") 
}

これは、ラムダパラメータでをするかを々にらせます。

verifiedByパラメータTとじであることにしてくださいT: Any? nullなでもそのバージョンのをでき
ることをします。ただし、 verifiedWithはnullをできません。

ISO 8のをレンダリングするためのJava 8 Temporalクラスのサンプル

こので

fun Temporal.toIsoString(): String = DateTimeFormatter.ISO_INSTANT.format(this)

これでにのことができます

val dateAsString = someInstant.toIsoString()

コンパニオンオブジェクトへのの

クラスをするは、のたとえば、 Somethingクラスのstatic lookingfromStringするなどは、クラスに
コンパニオンオブジェクトがあり、そのがコンパニオンオブジェクトでされているにのみします

class Something { 
    companion object {} 
} 
 
class SomethingElse { 
} 
 
fun Something.Companion.fromString(s: String): Something = ... 
 

https://riptutorial.com/ja/home 78

https://kotlinlang.org/docs/reference/object-declarations.html#companion-objects
https://kotlinlang.org/docs/reference/object-declarations.html#companion-objects


fun SomethingElse.fromString(s: String): SomethingElse = ... 
 
fun main(args: Array<String>) { 
    Something.fromString("") //valid as extension function declared upon the 
                             //companion object 
 
    SomethingElse().fromString("") //valid, function invoked on instance not 
                                   //statically 
 
    SomethingElse.fromString("") //invalid 
}

プロパティの

あなたがするのになプロパティをしたいとします。したがって、KotlinのKT-9686とKT- 13053で
されているように、 レイジープロパティデリゲートをってをキャッシュし、のインスタンス this 

をすることはできません。ただし、ここにはのがあります 。

このでは、プロパティはcolorです。これはなcolorCacheをしています。 thisはlazyがでないため
、 thisとにできます

class KColor(val value: Int) 
 
private val colorCache = mutableMapOf<KColor, Color>() 
 
val KColor.color: Color 
    get() = colorCache.getOrPut(this) { Color(value, true) }

なのためのコードからの

ビューをしたは、ビューのをすることができます。

Ankoによるオリジナルのアイデア

inline fun <reified T : View> View.find(id: Int): T = findViewById(id) as T 
inline fun <reified T : View> Activity.find(id: Int): T = findViewById(id) as T 
inline fun <reified T : View> Fragment.find(id: Int): T = view?.findViewById(id) as T 
inline fun <reified T : View> RecyclerView.ViewHolder.find(id: Int): T = 
itemView?.findViewById(id) as T 
 
inline fun <reified T : View> View.findOptional(id: Int): T? = findViewById(id) as? T 
inline fun <reified T : View> Activity.findOptional(id: Int): T? = findViewById(id) as? T 
inline fun <reified T : View> Fragment.findOptional(id: Int): T? = view?.findViewById(id) as? 
T 
inline fun <reified T : View> RecyclerView.ViewHolder.findOptional(id: Int): T? = 
itemView?.findViewById(id) as? T

val yourButton by lazy { find<Button>(R.id.yourButtonId) } 
val yourText by lazy { find<TextView>(R.id.yourTextId) } 
val yourEdittextOptional by lazy { findOptional<EditText>(R.id.yourOptionEdittextId) }

オンラインでメソッドをむ https://riptutorial.com/ja/kotlin/topic/613/メソッド
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32: 

Examples

の

Stringのは、インデックスstring[index]によってアクセスできるstring[index]です。

val str = "Hello, World!" 
println(str[1]) // Prints e

は、forループですることができます。

for (c in str) { 
    println(c) 
}

リテラル

Kotlinには、2のリテラルがあります。

エスケープ•
の•

エスケープされたは、をエスケープしてします。エスケープはバックスラッシュでいます。のエ
スケープシーケンスがサポートされています \t 、 \b 、 \n 、 \r 、 \' 、 \" 、 \\および\$ 

Unicodeエスケープシーケンス \uFF00ます。

val s = "Hello, world!\n"

トリプルクォート"""でられたのは、エスケープをまず、やそののをむことができます

val text = """ 
    for (c in "foo") 
        print(c) 
"""

するはtrimMarginでりくことができます。

val text = """ 
    |Tell me and I forget. 
    |Teach me and I remember. 
    |Involve me and I learn. 
    |(Benjamin Franklin) 
    """.trimMargin()
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のマージンプレフィックスはパイプです|これはtrimMarginのパラメータとしてできます。えば
trimMargin(">") 。

テンプレート

エスケープされたとののにテンプレートをめることができます。テンプレートはされるコードの
であり、そのはにされます。ドル$まり、でされています

val i = 10 
val s = "i = $i" // evaluates to "i = 10"

または、でまれたの

val s = "abc" 
val str = "$s.length is ${s.length}" // evaluates to "abc.length is 3"

にリテラルドルをめるには、バックスラッシュをしてエスケープします。

val str = "\$foo" // evaluates to "$foo"

エスケープをサポートしていないのはです。のでは、のをしてドルをすことができます。

val price = """ 
${'$'}9.99 
"""

Kotlinのは、 ==とされ、にであることがされます。

val str1 = "Hello, World!" 
val str2 = "Hello," + " World!" 
println(str1 == str2) // Prints true

は===でチェックされます。

val str1 = """ 
    |Hello, World! 
    """.trimMargin() 
 
val str2 = """ 
    #Hello, World! 
    """.trimMargin("#") 
 
val str3 = str1 
 
println(str1 == str2) // Prints true 
println(str1 === str2) // Prints false 
println(str1 === str3) // Prints true

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/8285/
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33: 

Javaのswitchとはに、 whenステートメントにはフォールスルーがありません。つまり、がした、
フローはにり、 breakはありません。 bahaviorsをのにしたいは、のをコンマでってくことができ
ます

when (x) { 
    "foo", "bar" -> println("either foo or bar") 
    else -> println("didn't match anything") 
}

Examples

のif

val str = "Hello!" 
if (str.length == 0) { 
    print("The string is empty!") 
} else if (str.length > 5) { 
    print("The string is short!") 
} else { 
    print("The string is long!") 
}

else-branchesはのifではオプションです。

としてのIf

ifをにすることができます

val str = if (condition) "Condition met!" else "Condition not met!"

ことにしてくださいelse-branchはオプションではありませんif -statementがとしてされています
。

これはとのelse ifステートメントをむのでもできます。

val str = if (condition1){ 
    "Condition1 met!" 
   } else if (condition2) { 
    "Condition2 met!" 
   } else { 
    "Conditions not met!" 
   }

ヒントKotlinはのをすることができますが、のにをけるだけのは、 val str: String =を
してみやすくします。
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if-else-ifチェーンのわりにwhen-statement

whenは、のelse ifブランチをつifのです。

when { 
    str.length == 0 -> print("The string is empty!") 
    str.length > 5  -> print("The string is short!") 
    else            -> print("The string is long!") 
}

if-else-ifチェーンをってかれたじコード

if (str.length == 0) { 
    print("The string is empty!") 
} else if (str.length > 5) { 
    print("The string is short!") 
} else { 
    print("The string is long!") 
}

ifのとに、elseブランチはオプションであり、きなだけくのブランチまたはいくつかのブランチを
できます。また、マルチラインブランチをすることもできます。

when { 
    condition -> { 
        doSomething() 
        doSomeMore() 
    } 
    else -> doSomethingElse() 
}

when-statementの

がえられると、 when -statementはをににします。は、 ==をしてわれます。は、NULLチェックを
し、 equalsをしてオペランドをします。にするものがされます。

when (x) { 
    "English" -> print("How are you?") 
    "German" -> print("Wie geht es dir?") 
    else -> print("I don't know that language yet :(") 
}

whenステートメントにはさらになマッチングオプションがいくつかあります。

val names = listOf("John", "Sarah", "Tim", "Maggie") 
when (x) { 
    in names -> print("I know that name!") 
    !in 1..10 -> print("Argument was not in the range from 1 to 10") 
    is String -> print(x.length) // Due to smart casting, you can use String-functions here 
}
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when-としての

ifのように、whenをとしてすることもできます

val greeting = when (x) { 
    "English" -> "How are you?" 
    "German" -> "Wie geht es dir?" 
    else -> "I don't know that language yet :(" 
} 
print(greeting)

としてするには、whenはなものでなければなりません。つまり、elseブランチをつか、ブランチ
をつのですべてのをカバーします。

when-のステートメント

whenさせるためにすることができますenumを

enum class Day { 
    Sunday, 
    Monday, 
    Tuesday, 
    Wednesday, 
    Thursday, 
    Friday, 
    Saturday 
} 
 
fun doOnDay(day: Day) { 
    when(day) { 
        Day.Sunday ->     // Do something 
        Day.Monday, Day.Tuesday ->     // Do other thing 
        Day.Wednesday ->  // ... 
        Day.Thursday ->   // ... 
        Day.Friday ->     // ... 
        Day.Saturday ->   // ... 
    } 
}

2のケースライン MondayとTuedsay 2にられるように、2つのenumをみわせることもできます。

あなたのケースがでない、コンパイルはエラーをします。 elseをしてデフォルトのケースをでき
ます

fun doOnDay(day: Day) { 
    when(day) { 
        Day.Monday ->     // Work 
        Day.Tuesday ->    // Work hard 
        Day.Wednesday ->  // ... 
        Day.Thursday ->   // 
        Day.Friday ->     // 
        else ->           // Party on weekend 
    } 
} 
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じをしてうことができますがif-then-else、 whenしているのをenumを、それがよりになります。

kotlin enumはこちらをごください

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/2685/
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34: 

Examples

のマッチングのイディオム

のローカルの

「のファイル」テンプレートよりも、のスペースはなくなりますが、のスペースはきくなります
。 whenがループにあるは、 "anonymous temporaries"テンプレートよりもします。この、のはル
ープのにするがあります。

import kotlin.text.regex 
 
var string = /* some string */ 
 
val regex1 = Regex( /* pattern */ ) 
val regex2 = Regex( /* pattern */ ) 
/* etc */ 
 
when { 
    regex1.matches(string) -> /* do stuff */ 
    regex2.matches(string) -> /* do stuff */ 
    /* etc */ 
}

のファイルをする

「のローカル」テンプレートよりも、のスペースはなくなりますが、のスペースはきくなります
。 expressionがループにあるwhenはしないでください。

import kotlin.text.regex 
 
var string = /* some string */ 
 
when { 
    Regex( /* pattern */ ).matches(string) -> /* do stuff */ 
    Regex( /* pattern */ ).matches(string) -> /* do stuff */ 
    /* etc */ 
}

パターンの

syntaxのwhen " - ful"をにエミュレートするがあります。これは、 whenのをよりにし、すべての
whenEntry whenをりさなければならないことからじるのプログラマーいをするwhenEntryです。この
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では、「のローカル」テンプレートまたは「のな」テンプレートのいずれかをビジターパターン
としてすることができます。

import kotlin.text.regex 
 
var string = /* some string */ 
 
when (RegexWhenArgument(string)) { 
    Regex( /* pattern */ ) -> /* do stuff */ 
    Regex( /* pattern */ ) -> /* do stuff */ 
    /* etc */ 
}

whenのラッパークラスの

class RegexWhenArgument (val whenArgument: CharSequence) { 
    operator fun equals(whenEntry: Regex) = whenEntry.matches(whenArgument) 
    override operator fun equals(whenEntry: Any?) = (whenArgument == whenEntry) 
}

Kotlinのの

このでは、 Regexクラスのほとんどののい、 RegexににしたnullをRegex、およびのがパターンのき
みとみみをにするをします。

RegExクラス
Kotlinでをするには、 Regex(pattern: String)クラスをし、そのオブジェクトでfind(..)や
replace(..)ようなをびすがあります。

inputにcまたはdがまれているにtrueをすRegexクラスをするの

val regex = Regex(pattern = "c|d") 
val matched = regex.containsMatchIn(input = "abc")    // matched: true

すべてのRegexですることは、がpatternとinputのマッチングにづいていることです。のにはがな
ものもあれば、のみがなものもあります。このでされているcontainsMatchIn(..)は、がで、このの
でします。

によるNullの
find(..)とmatchEntire(..)のMatchResult?オブジェクト。 ? Kotlinがnullをにするためには、 
MatchResultのMatchResultがです。

find(..)がnullをすとき、KotlinがRegexからnullをにするをす
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val matchResult = 
    Regex("c|d").find("efg")           // matchResult: null 
val a = matchResult?.value             // a: null 
val b = matchResult?.value.orEmpty()   // b: "" 
a?.toUpperCase()                       // Still needs question mark. => null 
b.toUpperCase()                        // Accesses the function directly. => ""

orEmpty()をすると、 bをnullにすることはできません? bをびすと、はです。

あなたがnullのこのないににしないなら、KotlinはJavaのようにヌルですることをにします!!

a!!.toUpperCase()                      // => KotlinNullPointerException

パターンのの
Kotlinは、Java をってJava をしています。これにより、Javaでな、バックスラッシュのないなパ
ターンをくことができます。のはでされます

"""\d{3}-\d{3}-\d{4}""" // raw Kotlin string 
"\\d{3}-\\d{3}-\\d{4}"  // standard Java string

findinputCharSequence、startIndexInt
MatchResult

inputはRegexオブジェクトのpatternとされます。 Matchresult?しますMatchresult? startIndexににす
るテキストをつオブジェクト。パターンがinputとしなかったはnull 。のはMatchResult?からされ
MatchResult?オブジェクトのvalueプロパティ。 startIndexパラメーターはで、は0です。

のをむからのなをするには

val phoneNumber :String? = Regex(pattern = """\d{3}-\d{3}-\d{4}""") 
    .find(input = "phone: 123-456-7890, e..")?.value // phoneNumber: 123-456-7890

inputにながない、phoneNumberはnullになりnull 。

findAllinputCharSequence、startIndexIntシー
ケンス
patternするinputからすべてのをします。

でられたすべてのを、とのあるテキストからするには

https://riptutorial.com/ja/home 88

https://kotlinlang.org/docs/reference/basic-types.html#string-literals
https://kotlinlang.org/docs/reference/basic-types.html#string-literals
https://kotlinlang.org/docs/reference/basic-types.html#string-literals
https://kotlinlang.org/docs/reference/basic-types.html#string-literals
https://kotlinlang.org/docs/reference/basic-types.html#string-literals
https://kotlinlang.org/docs/reference/basic-types.html#string-literals


val matchedResults = Regex(pattern = """\d+""").findAll(input = "ab12cd34ef") 
val result = StringBuilder() 
for (matchedText in matchedResults) { 
    result.append(matchedText.value + " ") 
} 
 
println(result) // => 12 34

matchedResultsは、 MatchResultオブジェクトをつMatchResultです。なしのinputでは、 findAll(..)
はのシーケンスをします。

matchEntireCharSequenceMatchResult

inputのすべてのがpatternとする、 inputとしいがされます。それのは、 nullがされます。

がの、をします。

val a = Regex("""\d+""").matchEntire("100")?.value             // a: 100 
val b = Regex("""\d+""").matchEntire("100 dollars")?.value     // b: null

matchesinputCharSequenceBoolean

がパターンとするにをします。そうでなければFalse。

2つのにだけがまれているかどうかをテストします。

val regex = Regex(pattern = """\d+""") 
regex.matches(input = "50")             // => true 
regex.matches(input = "50 dollars")     // => false

containsMatchInCharSequenceブール
のがパターンとするにをします。そうでなければFalse。

2つのになくとも1つのがまれているかどうかをテストする

Regex("""\d+""").containsMatchIn("50 dollars")       // => true 
Regex("""\d+""").containsMatchIn("Fifty dollars")    // => false

splitCharSequence、limitIntリスト
すべてのマッチのないしいリストをします。
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のないリストをすには

val a = Regex("""\d+""").split("ab12cd34ef")     // a: [ab, cd, ef] 
val b = Regex("""\d+""").split("This is a test") // b: [This is a test]

のリストには1つのがあります。のinputには3つのがあります。その、3つのからなるリストがら
れます。

CharSequence、String

inputのpatternすべてのをにきえます。

のすべてのをx

val result = Regex("""\d+""").replace("ab12cd34ef", "x") // result: abxcdxef

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/8364/
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35: 

Examples

アノテーションの

アノテーションは、メタデータをコードにするです。をするには、をクラスのにします。

annotation class Strippable

はメタアノテーションをつことができます

    @Target(AnnotationTarget.CLASS, AnnotationTarget.FUNCTION, 
AnnotationTarget.VALUE_PARAMETER, AnnotationTarget.EXPRESSION) 
    annotation class Strippable

はのクラスとに、コンストラクタをつことができます。

annotation class Strippable(val importanceValue: Int)

しかし、のクラスとはなり、のタイプにされています

JavaプリミティブInt、Longなどにする。•
•

クラスFoo :: class•
•

そのの•
のタイプの•

メタ

をするとき、のメタをしてメタをめることができます。

@Target でできるクラス、、プロパティ、などのなをします。•

@Retentionは、コンパイルされたクラスファイルにがされているかどうか、また、にリフレ
クションでできるかどうかをしますデフォルトではともtrueです。

•

@Repeatableは、のにしてじアノテーションをすることをにします。•

@MustBeDocumentedは、アノテーションがパブリックAPIのであることをし、されたAPIドキュ
メントにされているクラスまたはメソッドのシグネチャにめるがあります。

•

@Target(AnnotationTarget.CLASS, AnnotationTarget.FUNCTION, 
        AnnotationTarget.VALUE_PARAMETER, AnnotationTarget.EXPRESSION) 
@Retention(AnnotationRetention.SOURCE) 
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@MustBeDocumented 
annotation class Fancy

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/4074/
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36: 

Examples

KotlinのなはArray<T>されます。

のをするには、 emptyArray<T>()ファクトリをします。

val empty = emptyArray<String>()

されたサイズとでをするには、コンストラクタをします。

var strings = Array<String>(size = 5, init = { index -> "Item #$index" }) 
print(Arrays.toString(a)) // prints "[Item #0, Item #1, Item #2, Item #3, Item #4]" 
print(a.size) // prints 5

にはget(index: Int): Tとset(index: Int, value: T)があります。

strings.set(2, "ChangedItem") 
print(strings.get(2)) // prints "ChangedItem" 
 
// You can use subscription as well: 
strings[2] = "ChangedItem" 
print(strings[2]) // prints "ChangedItem"

プリミティブの

これらのは 、ボクシングをけるためにArray<T>からしませんが、じとメソッドをちます。

コトリン ファクトリ JVMタイプ

BooleanArray booleanArrayOf(true, false) boolean[]

ByteArray byteArrayOf(1, 2, 3) byte[]

CharArray charArrayOf('a', 'b', 'c') char[]

DoubleArray doubleArrayOf(1.2, 5.0) double[]

FloatArray floatArrayOf(1.2, 5.0) float[]

IntArray intArrayOf(1, 2, 3) int[]

LongArray longArrayOf(1, 2, 3) long[]

ShortArray shortArrayOf(1, 2, 3) short[]

average()はByte 、 Int 、 Long 、 Short 、 Double 、 Floatにしてされ、にDoubleします。
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val doubles = doubleArrayOf(1.5, 3.0) 
print(doubles.average()) // prints 2.25 
 
val ints = intArrayOf(1, 4) 
println(ints.average()) // prints 2.5

component1() 、 component2() 、... component5()はのをします

getOrNull(index: Int)は、indexがのはnullをし、そうでないはのをします。

first() 、 last()

toHashSet()はすべてののHashSet<T>をします

sortedArray() 、 sortedArrayDescending()は、のソートされたをつしいをしてします

sort() 、 sortDescendingをインプレースでソートする

min() 、 max()

の

Javaループとじループをしてをできますが、キーワードを:からinにするがあります。

val asc = Array(5, { i -> (i * i).toString() }) 
for(s : String in asc){ 
    println(s); 
}

forループのデータをすることもできます。

val asc = Array(5, { i -> (i * i).toString() }) 
for(s in asc){ 
    println(s); 
}

をする

val a = arrayOf(1, 2, 3) // creates an Array<Int> of size 3 containing [1, 2, 3].

クロージャをしてをする

val a = Array(3) { i -> i * 2 } // creates an Array<Int> of size 3 containing [0, 2, 4]

されていないをする

val a = arrayOfNulls<Int>(3) // creates an Array<Int?> of [null, null, null]
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されるはにnullなをちます。 nullをしないのは、されていないではできません。

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/5722/
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37: 

しい  Params = ...•

しい  Params {...}•

しい  Params  タイプ {...}•

fun < タイプ >   Params  タイプ {...}•

inline fun   Params  タイプ {...}•
{ ArgName  ArgType - > ...}•
{ ArgName - > ...}•
{ ArgNames - > ...}•
{ ArgName  ArgType   - > ...}•

パラメーター

パラメータ

の

Params にえられたとの Name : Type

タイプ のりの

ジェネリックプログラミングでされるパラメータずしもをすはない

ArgName にえられたの

ArgType ArgNameの

ArgNames コンマでられたArgNameのリスト

Examples

のをる

「ラムダ」にられるように、はのをパラメータとしてることができます。のをつをするためにな 
""はのとおりです

# Takes no parameters and returns anything 
() -> Any? 
 
# Takes a string and an integer and returns ReturnType 
(arg1: String, arg2: Int) -> ReturnType

たとえば、なの() -> Any?できます() -> Any?ラムダを2するをする
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fun twice(x: () -> Any?) { 
    x(); x(); 
} 
 
fun main() { 
    twice { 
        println("Foo") 
    } # => Foo 
      # => Foo 
}

ラムダ

ラムダは、、びしのにパラメータとしてするようにされるです。がな、これらはのにかれ-らは{}
でをむことでされています-> 。

{ name: String -> 
    "Your name is $name" //This is returned 
}

ラムダのののステートメントはにりです。

コンパイラがをできるにラムダをくと、はオプションです。

の

{ argumentOne:String, argumentTwo:String -> 
    "$argumentOne - $argumentTwo" 
}

ラムダが1つのしかとしないは、リストをしitわりに1つのをすることができます。

{ "Your name is $it" }

へののがラムダである、びしからかっこをにすることができます。

# These are identical 
listOf(1, 2, 3, 4).map { it + 2 } 
listOf(1, 2, 3, 4).map({ it + 2 })

ののに::けることで、をにびさずにをすることができます。これは、のをパラメータとしてけれ
るにすことができます。

fun addTwo(x: Int) = x + 2 
listOf(1, 2, 3, 4).map(::addTwo) # => [3, 4, 5, 6]

せずにをにされます(ParamTypeA, ParamTypeB, ...) -> ReturnType ParamTypeA 、 ParamTypeB ... 
ReturnType1はのりのタイプである`パラメータのタイプであり、。
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fun foo(p0: Foo0, p1: Foo1, p2: Foo2): Bar { 
    //... 
} 
println(::foo::class.java.genericInterfaces[0]) 
// kotlin.jvm.functions.Function3<Foo0, Foo1, Foo2, Bar> 
// Human readable type: (Foo0, Foo1, Foo2) -> Bar

レシーバであろうとメンバであろうとをつは、なったをっています。ダブルコロンのにレシーバ
のタイプをするがあります

class Foo 
fun Foo.foo(p0: Foo0, p1: Foo1, p2: Foo2): Bar { 
    //... 
} 
val ref = Foo::foo 
println(ref::class.java.genericInterfaces[0]) 
// kotlin.jvm.functions.Function4<Foo, Foo0, Foo1, Foo2, Bar> 
// Human readable type: (Foo, Foo0, Foo1, Foo2) -> Bar 
// takes 4 parameters, with receiver as first and actual parameters following, in their order 
 
// this function can't be called like an extension function, though 
val ref = Foo::foo 
Foo().ref(Foo0(), Foo1(), Foo2()) // compile error 
 
class Bar { 
    fun bar() 
} 
print(Bar::bar) // works on member functions, too.

しかし、のがオブジェクトである、はそのようなのインスタンスの1つだけであるため、パラメー
タリストからされます。

object Foo 
fun Foo.foo(p0: Foo0, p1: Foo1, p2: Foo2): Bar { 
    //... 
} 
val ref = Foo::foo 
println(ref::class.java.genericInterfaces[0]) 
// kotlin.jvm.functions.Function3<Foo0, Foo1, Foo2, Bar> 
// Human readable type: (Foo0, Foo1, Foo2) -> Bar 
// takes 3 parameters, receiver not needed 
 
object Bar { 
    fun bar() 
} 
print(Bar::bar) // works on member functions, too.

kotlin 1.1、リファレンスはにバインドすることもできます。これは、バウンドリファレンスとば
れます 。

1.1.0

fun makeList(last: String?): List<String> { 
    val list = mutableListOf("a", "b", "c") 
    last?.let(list::add) 
    return list 
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}

このは、がどのようにするかをすためにのみえられていることにしてください。のすべてのではいです。

しかし、なケースがあります。メンバとしてされたはできません。

class Foo 
class Bar { 
    fun Foo.foo() {} 
    val ref = Foo::foo // compile error 
}

はfunキーワードをしてされ、そのにとパラメータがきます。のりのをすることもできます。は
Unitです。のは{}まれています。りのがUnitの、は、のすべてのブランチにしてreturnをするがあ
ります。

fun sayMyName(name: String): String { 
    return "Your name is $name" 
} 

じものの

fun sayMyName(name: String): String = "Your name is $name" 

また、はできるのですることができます

fun sayMyName(name: String) = "Your name is $name" 

にが1つだけまれているは、のように、をしてわりにequalsをできます。のはにされます。

fun sayMyName(name: String): String = "Your name is $name" 

インライン

は、 inlineをしてinlineですることができます。この、びされるのではなく、Cのマクロのように
します。コンパイルにのコードにきえられます。これは、にラムダがパラメータとしてされるに
、パフォーマンスのをもたらすことがあります。

inline fun sayMyName(name: String) = "Your name is $name" 

Cマクロとのいの1つは、インラインがびされたスコープにインラインがアクセスできないことで
す。

inline fun sayMyName() = "Your name is $name" 
 
fun main() { 
    val name = "Foo" 
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    sayMyName() # => Unresolved reference: name 
}

Kotlinは +や* とをつみののセットをすることをにします。をするために、するのをつメンバまた
はをします。オーバーロードするoperatorにoperatoroperatorけるがある

data class IntListWrapper (val wrapped: List<Int>) { 
    operator fun get(position: Int): Int = wrapped[position] 
} 
 
val a = IntListWrapper(listOf(1, 2, 3)) 
a[1] // == 2

よりくのがここにあります

オンラインでをむ https://riptutorial.com/ja/kotlin/topic/1280/
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38: ののパラメータ
Varargキーワード  varargはメソッドでされ、のパラメータがけれられることをします。•

スプレッド 々のパラメータにをするびしでされるののアスタリスク * 。•

Examples

varargキーワードの

varargキーワードをしてをします。

fun printNumbers(vararg numbers: Int) { 
    for (number in numbers) { 
        println(number) 
    } 
}

これで、なのくのパラメータをにすことができます。

printNumbers(0, 1)                // Prints "0" "1" 
printNumbers(10, 20, 30, 500)     // Prints "10" "20" "30" "500"

Varargパラメータは、パラメータリストののパラメータでなければなりません 。

スプレッドをvarargにす

は、 スプレッド *をしてvarargにすことができます。

のがするとします...

fun printNumbers(vararg numbers: Int) { 
    for (number in numbers) { 
        println(number) 
    } 
}

あなたはのようにをすことができます...

val numbers = intArrayOf(1, 2, 3) 
printNumbers(*numbers) 
 
// This is the same as passing in (1, 2, 3)

スプレッドは、パラメータのですることもできます...

val numbers = intArrayOf(1, 2, 3) 
printNumbers(10, 20, *numbers, 30, 40) 
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// This is the same as passing in (10, 20, 1, 2, 3, 30, 40)

オンラインでののパラメータをむ https://riptutorial.com/ja/kotlin/topic/5835/ののパラメータ
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